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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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Active X, Microsoft, MS-DOS, Visual Basic, Visual C++, Windows and Windows NT are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and other countries. 

Cautions 

1. These materials are intended as a reference to assist our customers in the selection of the Renesas 
Technology Corp. product best suited to the customer's application; they do not convey any license 
under any intellectual property rights, or any other rights, belonging to Renesas Technology Corp. or 
a third party.

2. Renesas Technology Corp. assumes no responsibility for any damage, or infringement of any third-
party's rights, originating in the use of any product data, diagrams, charts, programs, algorithms, or 
circuit application examples contained in these materials.

3. All information contained in these materials, including product data, diagrams, charts, programs and 
algorithms represents information on products at the time of publication of these materials, and are 
subject to change by Renesas Technology Corp. without notice due to product improvements or 
other reasons.  It is therefore recommended that customers contact Renesas Technology Corp. or 
an authorized Renesas Technology Corp. product distributor for the latest product information 
before purchasing a product listed herein. 
The information described here may contain technical inaccuracies or typographical errors. 
Renesas Technology Corp. assumes no responsibility for any damage, liability, or other loss rising 
from these inaccuracies or errors. 
Please also pay attention to information published by Renesas Technology Corp. by various means, 
including the Renesas Technology Corp. Semiconductor home page (http://www.renesas.com).

4. When using any or all of the information contained in these materials, including product data, 
diagrams, charts, programs, and algorithms, please be sure to evaluate all information as a total 
system before making a final decision on the applicability of the information and products.  Renesas 
Technology Corp. assumes no responsibility for any damage, liability or other loss resulting from the 
information contained herein.

5. Renesas Technology Corp. semiconductors are not designed or manufactured for use in a device or 
system that is used under circumstances in which human life is potentially at stake.  Please contact 
Renesas Technology Corp. or an authorized Renesas Technology Corp. product distributor when 
considering the use of a product contained herein for any specific purposes, such as apparatus or 
systems for transportation, vehicular, medical, aerospace, nuclear, or undersea repeater use.

6. The prior written approval of Renesas Technology Corp. is necessary to reprint or reproduce in 
whole or in part these materials.

7. If these products or technologies are subject to the Japanese export control restrictions, they must 
be exported under a license from the Japanese government and cannot be imported into a country 
other than the approved destination. 
Any diversion or reexport contrary to the export control laws and regulations of Japan and/or the 
country of destination is prohibited.

8. Please contact Renesas Technology Corp. for further details on these materials or the products 
contained therein.

1. Renesas Technology Corp. puts the maximum effort into making semiconductor products better and 
more reliable, but there is always the possibility that trouble may occur with them. Trouble with 
semiconductors may lead to personal injury, fire or property damage. 
Remember to give due consideration to safety when making your circuit designs, with appropriate 
measures such as (i) placement of substitutive, auxiliary circuits, (ii) use of nonflammable material or 
(iii) prevention against any malfunction or mishap.

Keep safety first in your circuit designs! 

Notes regarding these materials

 
 

For inquiries about the contents of this document or product, fill in the text file the installer of the emulator 
debugger generates in the following directory and email to your local distributor. 
 
\SUPPORT\Product-name\SUPPORT.TXT 
 
Renesas Tools Homepage http://www.renesas.com/en/tools 



 
 

注意 
本文只是参考译文，前页所载英文版“Cautions”具有正式效力。 
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前  言 

 
 

在本用户手册中，有用PD308、PD30、PD79、PD77、PD38分别表示仿真调试程序M3T-PD308、
M3T-PD30、M3T-PD79、M3T-PD77、M3T-PD38的情况，请注意。 

 
 
PDxx（PD308/PD30/PD79/PD77/PD38）是对应 PC4701 系统的仿真调试程序。在个人计算机的 Windows 环

境下控制仿真器 PC4701，支援目标系统的调试。 
本用户手册记载了使用 PDxx 的基本信息，更详细的信息请参照附属于 PDxx 产品的联机帮助。 
 

对应仿真调试程序及其版本 
本用户手册对应以下的 PDxx： 
z PD79 V.4.10 Release 1B 
z PD77 V.4.10 Release 1B 
z PD38 V.5.10 Release 2 
 

术语定义 

在本用户手册中，有关仿真器名称的术语定义如下： 

z “PC4701U/M/HS”表示仿真器 PC4701U、PC4701M、PC4701HS 以及 PC4700H。在本文中有此记述时，

表示只对这些仿真器功能（操作）有效。 
z “PC4701L”表示仿真器 PC4701L 和 PC470L。在本文中有此记述时，表示只对这些仿真器功能（操作）

有效。 
 

程序使用权 

附属于 PDxx 产品的程序的使用权基于《软件使用权许诺合同书》。必须注意 PDxx 的程序只能用于客户的

产品开发而不能用于其他目的。 
另外，本用户手册不保证也不许诺对软件使用权的实施。 
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第1章 启动调试程序 

1.1 功能概要 
PD308、PD30、PD79、PD77、PD38 具有以下功能。 
 

1.1.1 实时 RAM 监控功能 
它是能在不损坏目标程序执行的实时性的情况下参照存储器内容变化的功能。仿真器 PC4701 系统具有 1K

字节的 RAM 监控区（不能分成多个区域）。 
 

1.1.2 暂停功能 
提供以下的暂停功能： 

z 软件暂停 

它是在即将执行指定地址的命令前停止目标程序的功能。能设定的断点数为 64 点。如果指定多个软件

断点，就在遇到某个断点时暂停。 
z 硬件暂停 

它是在检测到存储器的数据读/写、指令的执行及来自外部跟踪电缆输入信号的上升/下降沿时停止目

标程序的功能。能设定的事件内容根据目标 MCU 有所不同。指定的硬件暂停事件能进行以下的组合： 
·所有事件成立（And 条件） 
·某些事件同时成立（And（same）条件） 
·某个事件成立（Or 条件） 
·由指定状态转移引起的暂停状态突入（State Transition 条件） 

z 保护暂停 

它是在检测到 ROM 区的写数据和未使用区的存取（读/写/指令执行）时停止目标程序的功能。 
z 芯片暂停（只限于 PD79） 

它是在检测到存储器的读/写数据时停止目标程序的功能，不依存于仿真存储区、处理器模式的设定及

所使用的仿真器。对于软件暂停或硬件暂停不能设定的区域可以设定成芯片暂停。 
 

1.1.3 实时跟踪功能 
它是记录目标程序执行履历的功能，能记录 32K 周期的执行履历。能通过每个周期的总线信息、执行的指

令以及源程序，参照执行路径。 
 

1.1.4 区间时间测量功能 
它是测量指定区间的最小执行时间、最大执行时间、平均时间以及执行次数的功能，最大能同时测量 4 个

区间。 
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1.1.5 覆盖测量功能 
它是将目标程序执行（存取）的地址进行记录的功能（C0 覆盖）。在程序执行停止后，能把握未执行的地

址。通过在测试阶段使用此覆盖测量功能，能把握遗漏的测试项目。 
 

1.1.6 实时 OS 调试功能 
它是对使用实时 OS 的目标程序的实时 OS 依存部分进行调试的功能，能参照实时 OS 的状态显示和任务执

行履历等。 
 

1.1.7 GUI 输入/输出功能 
它是在窗口上模拟用户目标系统的键输入面板（按钮）和输出面板的功能。能使用输入面板的按钮、输出

面板的标号（字符串）和 LED。 
 

1.1.8 自定义功能 
它是把用户的独自功能（自定义命令、自定义窗口）追加到PDxx的功能。使用PDxx附属的CBxx（Custom 

Builder for PDxx）建立自定义命令和自定义窗口。 
 

1.2 有关仿真器 PC4701 
仿真器 PC4701 系统是用于 8/16 位 MCU 的仿真器的总称。通过和 PC4701 的仿真 POD 一起使用，能调试

用于各 MCU 的应用程序。 
 

1.2.1 功能表 
仿真器 

功能 
PC4701U/M/HS PC4701L 

RAM 监控 1K 字节的监控区 
S/W 暂停 64 点 
H/W 暂停 6 点（可组合） 1 点 
芯片暂停* 2 点 
实时跟踪 32K 周期 － 
C0 覆盖 256K 字节区域 － 
执行时间测量 Go→Stop、区间测量（4 点） Go→Stop 
保护暂停 存取保护 － 

* 只限于 PD79 
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1.3 在启动调试程序前 
在启动调试程序之前必须参照以下内容。 
 

1.3.1 和仿真器的通信方式 
根据仿真器种类，仿真器 PC4701 系统支持的通信方式不同。 
 

仿真器名 
通信方式 

PC4701U PC4701M PC4701HS PC4701L 
USB ○ × × × 
LAN ○ × ○ × 
LPT ○ ○ × × 

专用并行 × × ○ ○ 
串行 × ○ ○ ○ 

 

1.3.1.1 USB 通信 
只支持仿真器 PC4701U。 
z 对应的主机 OS 为 Windows Me/98/2000/XP，不能用于其它 OS。 
z 符合 USB 规格 1.1。 
z 不支持经由 USB 集线器的连接。 
z 能通过用USB电缆连接主机和仿真器PC4701U，以向导形式安装对应的设备驱动程序（需要预先安装对

应USB连接的PDxx）。详细内容请参照“1.3.3.1  USB通信”。 
z 使用的电缆附属于仿真器 PC4701U。 
 

1.3.1.2 LAN 通信 
只支持仿真器 PC4701U/HS。 
z 在通过 LAN 连接仿真器前，必须预先给仿真器设定 IP 地址等。 
z 在 Windows Me/98/2000/XP 的环境下和仿真器进行 LAN 通信时，需要改变 Windows 注册表的一部分信

息。详细内容请参照“1.3.3.4  Windows Me/98/2000/XP 和 LAN 通信的组合”。 
z 在仿真器 PC4701U 的情况下，能和经由路由器连接的其它网络的 PC4701U 进行连接。详细内容请参照

“1.3.3.2  PC4701U 和 LAN 通信的组合”。 
z 仿真器 PC4701U 和 PC4701HS 使用的 LAN 电缆不同。PC4701U 使用市场上出售的 LAN 电缆（只限

10BASE-T），而 PC4701HS 使用 PC4701HS 附属的 LAN 电缆（10BASE-T/5）。 
z 主机能直接和仿真器连接。详细内容请参照“2.1.2.5  LAN 通信的设定”。 
 

1.3.1.3 LPT 通信 
只支持仿真器 PC4701U/M。 
z 使用主机的并行（打印机）接口。 
z 使用的电缆附属于仿真器 PC4701U/M。 
z 支持 ECP、EPP、Byte、Nibble 4 种通信模式。能支持的通信模式取决于主机的 BIOS 设定（即使 BIOS

支持，也有不能使用的情况）。详细内容请参照“2.1.2.2  LPT 通信的设定”。 
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1.3.1.4 专用并行通信 
只支持仿真器 PC4701HS/L。 
z 需要对主机扩展专用的接口板 PCA4202G02（只支持 ISA 总线）。使用的电缆附属于仿真器 PC4701HS/L。 
z 在 Windows 2000/NT4.0 的环境下使用时，需要另外设定设备驱动程序。详细内容请参照“1.3.3.3  

Windows 2000/NT4.0 和专用并行通信的组合”。 
 

1.3.1.5 串行通信 
只在使用仿真器 PC4701M/HS/L 时支持。 
z 使用主机的 COM 接口。 
z 使用的电缆附属于仿真器 PC4701HS/L。 
 

1.3.2 固化软件的下载 
需要给仿真器 PC4701 下载与被连接的仿真 POD 对应的固化软件。如果符合以下任何一个条件，就必须在

接通仿真器电源后 2 秒以内按仿真器的系统复位开关。仿真器变为強制下载固化软件的模式。 
 
z 改变了仿真 POD。 
z 给仿真器下载的固化软件不明。 
z 初次使用 PDxx。 
z 在 PDxx 版本升级后。 
 
PDxx 在启动时调查给仿真器下载的固化软件的版本。如果该固化软件是旧版本，就变为下载固化软件的模

式。 
如果在仿真器变为強制下载固化软件模式的状态下启动 PDxx，就在启动时打开以下的对话框。请单击 OK

按钮，下载固化软件。 

 

 
◆注意事项◆ 
z 只有 PC4701U 才能通过 LAN 连接下载固化软件。在通过 LAN 连接 PC4701U 下载固化软件前，需要预

先给 PC4701U 注册 IP 地址等。详细内容请参照“1.3.3.2  PC4701U 和 LAN 通信的组合”。 
在使用 PC4701HS 时，必须通过其它通信方式（专用并行、串行）下载固化软件。 

z 在通过串行通信下载固化软件时，由于波特率固定为 9600bps，比较花费时间。因此，如果能使用其它

接口，则推荐使用那些接口的通信。 
 

1.3.3 仿真器启动前的设定 

1.3.3.1 USB 通信 
通过 Windows 的即插即用功能检测 USB 设备的连接，自动安装对应的设备驱动程序。 
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＜＜USB 设备驱动程序的安装＞＞ 
通过 Windows 的即插即用功能检测 USB 设备。如果检测到 USB 设备，就启动用于安装设备驱动程序的向

导。请按照以下的步骤安装 USB 设备驱动程序： 
 
1. 使用 USB 电缆连接主机和仿真器 PC4701U。 
2. 将仿真器 PC4701U 的通信接口设定开关（背面的面板）设定为“USB”，并接通电源。 
3. 将打开以下的对话框。 

 

4. 如果继续跟随着向导，用于指定设置信息文件（inf 文件）的对话框就会打开。请指定安装 PDxx 的目

录下的 Drivers 目录（例：c: \mtool\pdxx\drivers）的 musbdrv.inf 文件。 
 
◆注意事项◆ 
z 为了安装 USB 设备驱动程序，需要预先安装使用的 PDxx。 
z USB 通信不能用于 Windows Me/98/2000/XP 以外的 OS。 
z 在使用 Windows 2000/XP 的情况下，必须持有 Administrator 权限的用户才能安装 USB 设备驱动程序。 
z 在安装中可能会显示“找不到设备驱动程序本体 musbdrv.sys”的信息。由于 musbdrv.sys 保存在和

musbdrv.inf 文件相同的目录下，所以请指定此目录。 
 

1.3.3.2 PC4701U 和 LAN 通信的组合 
在将仿真器和 LAN 连接前，需要预先给仿真器注册 IP 地址等。对于出厂设定的仿真器 PC4701U，能使用

PDxx 附属的实用程序 setip.exe，给仿真器设定 IP 地址等。 
 

＜＜使用 SETIP 的 LAN 通信的设定＞＞ 
能使用 PDxx 附属的实用程序 SETIP，给出厂设定的仿真器设定 IP 地址等。SETIP 检测连接在同一网络上

的出厂设定的 PC4701U，进行 LAN 通信的设定。 
SETIP 被保存在安装 PDxx 目录下的 Utility 目录（例：c:\mtool\pdxx\utility）。文件名是 setip.exe。 
 
必须按照以下步骤给 PC4701U 注册 IP 地址： 
1. 通过 LAN 电缆将仿真器 PC4701U 连接到和主机相同的网络（同一子网络）。 
2. 将仿真器 PC4701U 的通信接口设定开关（背面的面板）设定为“LAN”，并接通电源。 
3. 启动 SETIP，打开以下的对话框，显示连接在网络上的 PC4701U 信息（在 MAC 地址后面显示 PC4701U

的产品序号）。 

 

要注册 IP 地址时单击 Next 按钮，要中止注册时单击 Close 按钮。如果没有显示，就必须在确认通信接

口设定开关后重新接通电源。然后，单击 Search 按钮。 
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4. 如果单击 Next 按钮，就打开以下的对话框。必须设定 IP 地址、子网掩码、端口号、默认网关的 IP 地

址。在同一网络的同一子网掩码上使用 PC4701U 时，能省略默认网关的 IP 地址。 

 

端口号必须指定 4 位的任意数值（在 PDxx 启动时输入该数值）。关于 IP 地址、子网掩码、默认网关

的指定内容，请向网络管理者询问。 
5. 单击对话框的 Set 按钮。给仿真器 PC4701U 注册指定的 IP 地址等。在正确注册的情况下，将打开以下

的对话框。 

 

在确认对话框的内容后，单击 OK 按钮。 
6. 重新接通仿真器 PC4701U 的电源。注册的 IP 地址在重新接通电源后才有效。 
 
◆注意事项◆ 
z 如果在同一网络上连接了多台出厂设定的 PC4701U，就只显示最初检测到的 PC4701U。 
z 已经设定了 IP 地址的 PC4701U 不能通过 SETIP 检测。此时，必须在用其它通信接口连接后，通过 Init

对话框重新注册 IP 地址。关于通过 Init 对话框进行的 IP 地址设定，请参照“2.1.2.5  LAN 通信的设定”。 
 

1.3.3.3 Windows 2000/NT4.0 和专用并行通信的组合 
专用并行通信只支持仿真器 PC4701HS/L。在使用专用并行通信时，需要专用接口板 PCA4202G02（另购）。

另外，在 Windows 2000/NT4.0 的环境下使用专用并行通信时，需要将 PCA4202G02 使用的 I/O 地址（7 字节）

的起始地址注册到 Windows 的注册表信息中（在出厂时 PCA4202G02 的 I/O 地址设定为 100h）。如果在以下情

况时，就使用 PDxx 附属的实用程序 setPca4202.exe，将 PCA4202G02 使用的 I/O 地址（7 字节）的起始地址注

册到注册表信息中。 
 
z 在初次使用 PDxx 时 
z 在设定的 I/O 地址（+7 字节）和其它设备出现竞争时 
 
setPca4202.exe 被保存在安装 PDxx 的目录下的 Drivers 目录下（例：c:\mtool\pdxx\drivers）。 
I/O 地址能按照以下步骤设定： 
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1. 启动 setPca4202.exe，打开以下的对话框。 

 

2. 用 16 进制将设定在并行接口板 PCA4202G02 的 I/O 地址输入到对话框的“I/O Address”栏，然后单击

对话框的 OK 按钮。 
3. 重新启动 Windows（I/O 地址的设定在重新启动后才有效）。 
 
◆注意事项◆ 
z 持有 Administrator 权限的用户才能执行 setPca4202.exe。无 Administrator 权限的用户不能改变 I/O 地址。 
z 有关 PCA4202G02 请参照《PCA4202G02 操作说明书》。 
 

1.3.3.4 Windows Me/98/2000/XP 和 LAN 通信的组合 
在 Windows Me/98/2000/XP 的环境下将仿真器和 LAN 连接时，需要设定以下的 Windows Me/98/2000/XP

注册表： 
 

OS 关键字 值 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ Windows Me/98 

Services\VxD\MSTCP\SackOpts
0 

（REG_SZ） 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\ Windows 2000/XP 

Services\Tcpip\Parameters\SackOpts
0 

（REG_DWORD） 

 
如果执行注册表设定程序 Sack.exe，就能设定上述注册表。在解除注册表设定时，必须执行注册表解除程

序 UnSack.exe。 
Sack.exe 和 UnSack.exe 被保存在安装 PDxx 目录下的 Utility 目录（例：c:\mtool\pdxx\utility）。 
 
◆注意事项◆ 
z 在使用 Windows 2000/XP 时，必须持有 Administrator 权限的用户才能执行 Sack.exe 和 UnSack.exe。无

Administrator 权限的用户不能设定注册表。 
 

＜补充＞ 
Windows Me/98/2000/XP 的 TCP 支持“Selective Acknowledgments（SACK）”。 
SACK 是为了提高像卫星通信那样的具有高频带和高延迟网络的通信性能的功能。详细内容请参照

RFC2018。 
Windows Me/98/2000/XP 的默认值设定为允许 SACK 的支持。但是要在 Windows Me/98/2000/XP 的环境下

将仿真器和 LAN 连接时，需要禁止 SACK 的支持。能通过设定上述注册表禁止 SACK 的支持。 
另外，如果在禁止 SACK 支持的情况下使用象卫星通信那样具有高频带和高延迟的网络，和支持 SACK 的

情况相比有可能降低通信性能。 
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1.4 调试程序的启动 
在启动调试程序时，单击 Windows 的开始菜单，选择 

 
程序（P）→[RENESAS-TOOLS]→[PDxx V.x.xx Release x]→[PDxx]。 

 
如果正常启动，就打开 Init 对话框。 
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第2章 设置调试程序 

通过启动 PDxx 后打开的 Init 对话框进行调试程序的设置。 
此对话框设定的内容在下次启动时也有效。 

 

选项卡

HelpCancel
 

 
产品名 

选项卡名 
PD308 PD30 PD79 PD77 PD38 

MCU ○ ○ ○ ○ ○ 
Debug Information ○ ○ ○ ○ ○ 
Resume ○ ○ ○ ○ ○ 
Clock ○ ○ ○ ○ ○ 
Download ○ ○ × ○ ○ 
Compiler × ○ × × × 
F/W and Work Area × ○ × × × 
Memory Extention Mode × ○ × × × 

 
为了在下次启动调试程序时不打开 Init 对话框，请选定 Init 对话框下部的 Next Hide。 
能通过以下任何一种方法打开 Init 对话框： 
z 在启动调试程序后选择菜单[Environment]→[Init...]。 
z 在按下 Ctrl 按钮的同时启动 PDxx。 
 

2.1 MCU 选项卡 
指定 MCU 文件和通信接口。 
指定的内容在下次启动时也有效。 
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2.1.1 MCU 文件的指定 

 

单击“Refer”按钮，打开文件选择对话框。请指定相应的 MCU 文件，MCU 文件被保存在安装 PDxx 的目

录下（例：c:\mtool\pdxx\mcufiles）。 
z MCU 文件是保存目标 MCU 固有信息的文件。 
z 指定的 MCU 文件被显示在 MCU 选项卡的 MCU 域。 
 
如果对应的 MCU 文件不包含在调试程序/仿真 POD 中，就需要新建 MCU 文件。 
关于建立方法请参照以下说明： 
z MCU 文件的建立（用于 PD308） → 2.9.1 
z MCU 文件的建立（用于 PD30） → 2.9.2 
z MCU 文件的建立（用于 PD38） → 2.9.3 
 

2.1.2 通信接口的指定 
显示内容根据指定的通信接口而不同（下图是在选择专用并行通信时）。 

 

 
另外，可使用的通信接口根据仿真器而不同。 
各通信接口的设定如下所示： 
z USB 通信（PC4701U） 
z LPT 通信（PC4701U/M） 
z 专用并行通信（PC4701HS/L） 
z 串行通信（PC4701M/HS/L） 
z LAN 通信（PC4701U/HS） 
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2.1.2.1 USB 通信的设定 
USB 通信使用个人计算机的 USB 接口。USB 通信只能用于仿真器 PC4701U，并符合 USB1.1。 
 

＜＜USB 通信的设定＞＞ 
在进行 USB 通信前，需要预先安装专用的设备驱动程序。关于 USB 设备驱动程序的安装请参照“1.3.3.1 

USB 通信”。 
 
在设定 USB 通信时，必须单击 MCU 选项卡内的单选按钮“USB”。 

 

 

2.1.2.2 LPT 通信的设定 
LPT 通信使用个人计算机的并行接口（打印机接口），用于仿真器 PC4701U/M。 
 

＜＜LPT 通信的设定＞＞ 
在设定 LPT 通信时，必须单击 Init 对话框 MCU 选项卡的单选按钮“LPT”。显示如下： 

 

必须给 Type 域指定将使用的 LPT 接口的通信模式。 
z LPT 通信有 Nibble、Byte、ECP 以及 EPP 4 个通信模式。这些通信模式是由国际规格 IEEE1284 规定的

通信模式，根据所使用的个人计算机，能使用的通信模式不同。EPP、ECP 模式的通信速度最快，其次

是 Byte 模式，最后是 Nibble 模式。 
z AUTO 模式自动检测能使用的最快的通信模式。根据所使用的个人计算机，也有不能正常自动检测的情

况。如果在 AUTO 模式的启动失败，就必须确认在 BIOS 设置中设定的并行端口的通信模式，并给 Type
域指定该通信模式。 

z BIOS 设置的启动方法和 BIOS 设置的方法根据所使用的个人计算机而不同，请参照个人计算机的使用

说明书。 
在 BIOS 设置的显示 通信模式 

SPP：Standard Parallel Port、Output Only Nibble 
Bidirectional、Bi-directional Byte 
ECP：Extended Capabilities Port ECP 
EPP：Enhanced Parallel Port EPP 

 
必须给 I/O 地址域指定并行端口的 I/O 地址。在 BIOS 设置中以下的任意一个地址被设定为有效（请确认）： 
z 378h 
z 278h 
 
◆注意事项◆ 
IAR 公司的 C 编译程序也使用此打印机（并行）端口。 
如果在 LPT 通信的 ECP 模式使用 PDxx 和仿真器 PC4701U/M，就会产生不能使用 IAR 公司的 C 编译程序

进行编译的现象。 
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在不能编译时，请采取以下任何一种对应方法： 
z 用 ECP 模式以外的模式连接 PDxx 和仿真器 PC4701U/M。 
z 在结束 PDxx 的状态下编译。 
 

2.1.2.3 专用并行通信的设定 
专用并行通信使用插在个人计算机扩展槽（ISA 总线）的专用并行接口电路板 PCA4202G02（另购）。 
专用并行通信只能用于仿真器 PC4701HS 或者 PC4701L。 
 

＜＜专用并行通信的设定＞＞ 
在设定专用并行通信时，必须单击 Init 对话框 MCU 选项卡的单选按钮“Parallel”。显示如下： 

 

必须给 I/O 地址指定域设定在专用接口板 PCA4202G02 设定的 I/O 地址值。 
z I/O 地址的指定必须用 16 进制数的数值输入（不能附加表示基数的前缀）。 
z 关于 PCA4202G02 的 I/O 地址设定请参照《PCA4202G02 操作说明书》。 
 
◆注意事项◆ 
z Windows 2000/NT4.0 和专用并行接口的组合 

需要给专用并行通信的设备驱动程序预先指定 PCA4202G02 使用的 I/O 地址。详细内容请参照“1.3.3.3 
Windows 2000/NT4.0 和专用并行通信的组合”。 

 

2.1.2.4 串行通信的设定 
串行通信使用个人计算机的串行接口（RS-232C）。串行通信能用于仿真器 PC4701M/HS/L。 
 

＜＜串行通信的设定＞＞ 
在设定串行通信时，单击 MCU 选项卡的单选按钮“Serial”。显示如下： 

 

必须给 Port 域指定将使用的串行接口的通信端口，给 Baud Rate 域指定波特率。 
 

2.1.2.5 LAN 通信的设定 
LAN 通信使用个人计算机的 LAN 接口。 
在使用 LAN 通信前，首先需要将仿真器的 IP 地址、端口号以及子网掩码注册给仿真器（如果没有注册，

LAN 通信就不能使用），然后设定 LAN 通信。 
LAN 通信能用于仿真器 PC4701U/HS。 
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＜＜IP 地址和子网掩码的注册＞＞ 
使用其它通信方式启动 PDxx。在启动后选择菜单[Environment]→[Init...]，打开 Init 对话框。其次，单击

MCU 选项卡的 Target 按钮，打开 Target 对话框。 

 

必须给 IP Address 域指定仿真器的 IP 地址，给 Port 域指定端口号，给 SubNetMask 域指定子网掩码（需要

预先在网络环境注册仿真器的 IP 地址）。 
在使用 PC4701U 时，Default Gateway 域变为有效，必须指定默认网关的 IP 地址。在同一网络的同一子网

掩码上使用 PC4701U 时，可以省略默认网关的 IP 地址。 
 
z IP 地址和子网掩码必须以 10 进制数指定 4 个字节，各字节用“.”隔开。关于 IP 地址和子网掩码请与

网络管理者商谈。 
z 给 Port 域设定的端口号是用于识别在 LAN（TCP/IP）通信中服务器侧（仿真器）的进程处理序号。必

须以 16 进制数指定设定于仿真器的端口号（不能附加表示基数的前缀）。 
 
单击 Target 对话框的“OK”按钮，关闭 Target 对话框。在返回到 Init 对话框后，单击“OK”按钮。 
然后，结束 PDxx。 
 

＜＜LAN 通信的设定＞＞ 
启动 PDxx，单击 Init 对话框 MCU 选项卡的单选按钮“LAN”。显示如下： 

 

 
必须给 IP Address 域指定仿真器的 IP 地址（在 Target 对话框指定的值）。IP 地址必须以 10 进制数指定 4

个字节，各字节用“.”隔开。 
必须给 Port 域指定端口号（在 Target 对话框指定的值）。 
 

＜＜和仿真器 1 対 1 的 LAN 连接＞＞ 
通过利用市场出售的 10BASE-T 交叉转换电缆，能用 LAN（TCP/IP）直接连接 PC 市场出售的 LAN 卡和仿

真器 PC4701U/HS。在这种情况下，不需要 HUB（集线器）。 
10BASE-T 交叉转换电缆是将直线 LAN 电缆的 10BASE-T 插针式端子转换为交叉 LAN 电缆的 10BASE-T

插针式端子的电缆。 
在将市场出售的交叉转换电缆连接到用于仿真器连接的直线 LAN 电缆（仿真器附属品）的 10BASE-T 插针

式端子后，将此 10BASE-T 插针式端子连接到 LAN 卡。 
LAN 通信的设定和通常的 LAN 通信的设定相同。 
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2.1.3 时钟频率的指定 
必须在 Time Count Resource 群的 MCU Clock 域指定目标 MCU 的工作时钟（MHz 单位）。 
对指定值必须考虑时钟的分频比（PD79 除外）。 
在以 10MHz/4 分频使用 MCU 时，工作时钟必须指定“2.5”。 

 

 

2.2 Debug Information 选项卡 
指定调试信息的保存场所。 
指定的内容从下次下载开始有效，并且在下次启动时也有效。 

 

 

2.2.1 调试信息保存场所的指定 
调试信息的保存方式有保存于存储器的 On Memory 方式和保存在临时文件上的按需（On Demand）方式。 

On Memory 由于使用存储器，能快速处理。 
On Demand 能减少存储器的使用量。 

 
选择保存方式（默认值为 On Memory 方式）。 

 

 
在选择按需方式时，必须给 Temp Dir 域指定临时文件的保存目录。 
如果没有指定目录，就在和下载的装入模块文件的相同目录中建立暂存文件。 
 

2.3 Clock 选项卡 
指定目标时钟。 
指定的内容在下次启动时也有效。 
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2.3.1 目标时钟的指定 
必须按照目标单片机的使用时钟改变设定（默认值为 Internal）。 
（PD38 没有 Sub 时钟的指定。） 

 

在设定成内部时钟时选择 Internal，在指定成外部时钟时选择 External。 
 

2.4 Compiler 选项卡 
指定使用的 C 编译程序。 
只有 PD30 支持此选项卡。指定的内容在下次启动时也有效。 
 

2.4.1 使用编译程序的指定 
目标模块（IEEE-695 格式）文件的输出形式根据使用的编译程序有一部分不同。 
因此，必需指定建立目标模块文件的编译程序。 

 

必须按照使用的编译程序改变指定（默认值为瑞萨 C 编译程序 NC30）。 
 

2.5 F/W and Work Area 选项卡 
指定固化软件和工作区。 
只有 PD30 支持此选项卡。指定的内容在下次启动时也有效。 
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2.5.1 固化软件的文件选择 

 

通常，请单击 F/W 群的 Default 单选按钮。 
在有必要下载和记述在 MCU 文件中不同的固化软件的文件时，单击 Select 单选按钮。 
F/W Name 列表框只有在单击 Select 单选按钮时才有效。 
 

2.5.2 工作区的指定 

 

给 Work Area 群的 Work Area Start Address 域指定将用作工作区的起始地址。 
仿真器将 MCU 的内部保留区（未使用区）作为调试用的工作区（约使用 10 字节）使用。 
必须将工作区指定在该 MCU 的内部保留区的范围内。 
默认工作区的起始地址为 2C00h。 
在调试工作区为内部 RAM 区的单片机（M16C/62 群的 RAM 20K 字节版等）时，有必要改变工作区。 
 

2.6 Memory Extension Mode 选项卡 
指定存储器扩展模式。 
此选项卡只有在 Init 对话框的 MCU 选项卡指定了支持存储空间扩展功能的单片机（M16C/62 群）的 MCU

文件的情况下才有效。 
只有 PD30 支持此选项卡。指定的内容在下次启动时也有效。 

 

 

2.6.1 存储空间扩展模式的指定 
指定存储空间扩展模式。 
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z 在使用通常模式时，单击 Normal 单选按钮。 
z 在使用扩展模式 1 时，单击 Ext1 单选按钮。 
z 在使用扩展模式 2 时，单击 Ext2 单选按钮。 
在不能指定存储空间扩展模式时，请确认在 Init 对话框的 MCU 选项卡指定的 MCU 文件的第 8 行的信息。 
在第 8 行为“0”时，不能选择存储空间扩展模式。 
 
◆注意事项◆ 
根据存储空间扩展模式，功能会有限制。 
 
存储空间扩展模式 1 
z 在程序窗口和源窗口的反汇编模式显示存储空间扩展区时，如果在目标程序执行中伴有上下滚动等窗口

的重新显示操作，就可能出现和希望不同的显示内容。 
z 解析总线信息（地址总线、数据总线等），实现仿真器的以下功能： 

·RAM 监控功能（RAM 监控窗口、C 监视窗口等） 
·覆盖测量功能（覆盖窗口、Coverage 命令等） 
·存储器保护功能（保护窗口、protect 命令等） 
对于存储体重复区，MCU 用 Fetch（取指令）存取程序存储体以及用 Read/Write 存取数据存储体。此

时，不给总线输出能辨别被存取的存储体的信号。因此，上述功能可能出现和希望不同的运行。 
z 追加了以转储格式参照存储体重复区的内部 ROM 的存储器参照命令（以下命令）。 

另外，在目标程序执行中不能使用 DA 命令。 
命令名 缩短名 内容 

DumpByte2 DB2 带存储体指定的 DumpByte（以 1 字节单位显示存储器内容） 
DumpWord2 DW2 带存储体指定的 DumpWord（以 2 字节单位显示存储器内容） 
DumpLword2 DL2 带存储体指定的 DumpLword（以 4 字节单位显示存储器内容） 

z 根据目标程序，如果在 MCU 从通常模式转换到存储空间扩展模式 1 之前对存储体重复区进行存储器参

照/改变，就可能出现和希望不同的运行。 
z 启动 PD30 后的存储器映像如下： 

起始地址 结束地址 设定 注意点 
00000 003FF External 不可改变（SFR 区） 
00400 03FFF Internal 不可改变内部 RAM 区 
04000 2FFFF External 不可改变 
30000 FFFFF Internal  

 
存储空间扩展模式 2 
z 追加了带存储体指定的存储器参照命令。必须使用以下命令对存储体重复区进行存储器参照/改变： 

命令名 缩短名 内容 
DumpByte2 DB2 带存储体指定的 DumpByte（以 1 字节单位显示） 
DumpWord2 DW2 带存储体指定的 DumpWord（以 2 字节单位显示） 
DumpLword2 DL2 带存储体指定的 DumpLword（以 4 字节单位显示） 
SetMemoryByte2 MB2 带存储体指定的 SetMemoryByte（以 1 字节单位改变） 
SetMemoryWord2 MW2 带存储体指定的 SetMemoryWord（以 2 字节单位改变） 
SetMemoryLword2 ML2 带存储体指定的 SetMemoryLword（以 4 字节单位改变） 
FillByte2 FB2 带存储体指定的 FillByte（以 1 字节单位填充） 
FillWord2 FW2 带存储体指定的 FillWord（以 2 字节单位填充） 
FillLword2 FL2 带存储体指定的 FillLword（以 4 字节单位填充） 
MOVE2 － 带存储体指定的 MOVE（以 1 字节单位传送） 
MOVEWord2 MOVEW2 带存储体指定的 MOVEWord（以 2 字节单位传送） 
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z 解析总线信息（地址总线、数据总线等），实现仿真器的以下功能： 
·RAM 监控功能（RAM 监控窗口、C 监视窗口等） 
·覆盖测量功能（覆盖窗口、Coverage 命令等） 
·存储器保护功能（保护窗口、protect 命令等） 
·硬件事件检测（H/W 暂停事件*、实时跟踪事件*、区间时间测量事件等） 

MCU 根据存储体选择寄存器的值转换存取的存储体。此时，不给总线输出能辨别被存取的存储体的信

号。因此，上述功能可能出现和希望不同的运行。 
 

* 在状态转移暂停/跟踪窗口，作为组合条件，通过对要检测的硬件事件和存储体选择寄存器指定

同时 And（same time），能检测存储体重复区的硬件事件。 
 
z 根据目标程序，如果 MCU 在从通常模式转换到存储空间扩展模式 2 之前对存储体重复区进行存储器参

照/改变，就可能出现和希望不同的运行。 
z 启动 PD30 后的存储器映像如下： 

起始地址 结束地址 设定 注意 
00000 003FF External 不可改变（SFR 区） 
00400 3FFFF Internal 不可改变内部 RAM 区 
04000 BFFFF External 不可改变 
C0000 FFFFF Internal  

 

2.7 Download 选项卡 
指定更新装入模块时的运行。 
PD79 没有此选项卡。指定的内容在下次启动时也有效。 
 

2.7.1 下载后的目标复位 

 

必须指定在下载目标程序后是否立即对目标进行复位。 
Reset Disable 不复位。 
Reset Enable 复位（默认值）。 
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2.8 Resume 选项卡 
指定在启动调试程序时的运行。 
指定的内容在下次启动时也有效 

 

 

2.8.1 脚本命令的自动执行 
为了在启动调试程序时自动执行脚本命令，请单击“Refer”按钮，指定要执行的脚本文件。 

 

通过单击“Refer”按钮，打开文件选择对话框。 
指定的脚本文件被显示在 Init File:域。 
在不需要自动执行脚本命令时，请删除显示在 Init File:域的字符串。 
 

2.8.2 恢复上次结束时的窗口状态 
为了恢复上次调试程序结束时的窗口状态（窗口位置、窗口大小），请选定“Resume”复选框（恢复默

认值）。 

 

 

2.8.3 装入模块的重新下载 
在重新下载装入模块（目标程序）时，请选定“AutoDownLoad”复选框（默认值为不重新下载）。 

 

 

2.9 MCU 文件的建立 

2.9.1 PD308 
MCU 文件按序记述以下内容。 
必须以 16 进制数记述数据，不能附加表示基数的前缀。 
 
1. SFR 区的起始地址 
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2. SFR 区的最终地址 
3. RAM 区的起始地址 
4. RAM 区的最终地址 
5. ROM 区的起始地址 
6. ROM 区的最终地址 
7. 对象固化软件的文件名 

不能在末尾记述表示仿真器种类的 m.s、h.s、l.s。 
 
◆注意事项◆ 
z 用 MCU 文件指定为 ROM 区的区域不能通过程序进行写操作。 

即使对该区域执行写指令，也不能写值。但是，能通过转储命令等对存储器写值（只限由 MAP 命令映

像到 Internal 区的情况）。 
z 如果给该区域配置了 RAM，就需要改变 MCU 文件的设定。 
 

2.9.1.1 记述例 
举例如下： 

0 
3FF 
400 
2BFF 
FC0000 
FFFFFF 
M30800 

 

2.9.2 PD30 
MCU 文件按序记述以下内容。 
必须指定文件名为 MCU 名、扩展名为“mcu”。 
 
1. SFR 区的起始地址 
2. SFR 区的最终地址 
3. RAM 区的起始地址 
4. RAM 区的最终地址 
5. ROM 区的起始地址 
6. ROM 区的最终地址 
7. 对应固化软件的文件名 *1 
8. 存储空间扩展功能的有无指定 *2 
 
必须以 16 进制数记述各地址。另外，不能附加表示基数的前缀。 
 

*1 指定与使用的单片机对应的固化软件文件（参照下表）。 
不能记述表示仿真器种类的末尾的 m.s、h.s、l.s。 

MCU 指定固化软件文件名 
M16C/60 群 M30600 
M16C/61 群 M30600 
M16C/62 群 M30620B 
M16C/20 系列 M30620B 

在改造仿真 POD 用的 MCU 文件中，可能有固化软件文件名不同的情况。 
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*2 指定是否支持存储空间扩展功能。 
在支持存储空间扩展功能的单片机（M16C/62 群等）时记述“1”，在不支持时记述“0”。 
只有在记述“1”的情况下，才能通过 Init 对话框的 Memory Extention Mode 选项卡指定存储器扩

展模式。 
 
◆注意事项◆ 
z 通过 MCU 文件指定为 ROM 区的区域不能由程序进行写操作。 

即使对该区域执行写指令，也不能写值。但是，能通过转储命令等给存储器写值。（只限由 MAP 命令

映像到 Internal 区的情况）。 
z 如果给该区域配置了 RAM，就需要改变 MCU 文件的设定。 
 

2.9.2.1 记述例 
举例如下： 

0 
3FF 
400 
2BFF 
F0000 
FFFFF 
M30600 
0 

 

2.9.3 PD38 
MCU 文件按序记述以下内容。 
必须在参照使用单片机的数据表等的基础上记述 1～4 项的信息。 
必须以 16 进制数记述数据。不能附加表示基数的前缀。 
 
1. 堆栈页选择位的位序号 
2. CPU 模式寄存器的地址 
3. 堆栈的结束地址 *1 
4. 复位向量的地址 
5. POD 序号 *2 
6. 对象固化软件的文件名 

不能在末尾记述表示仿真器种类的 m.s、h.s、l.s。 
7. MCU 信息序号 *3 
 

*1 堆栈的结束地址 
必须指定用作堆栈区的最终地址。此时，必须考虑 CPU 模式寄存器的堆栈页选择位的初始值（堆

栈页选择位的初始值根据单片机而不同）。对于堆栈页选择位的初始值为“0”的单片机，能指

定的范围是 0 页地址（0h～FFh）；对于初始值为“1”的单片机，能指定的范围是 1 页地址（100h～
1FFh）。 
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*2 POD 序号 
POD 名 POD 序号 固化软件名 对应单片机 

M38000T-FPD 
M38000TL-FPD
M38000TL2-FPD 

0 M38000 7200/7450/7470/38000/ 
7500 系列（7507、7510、7515、7520 群）*4 

M37207T-RPD 80 M38000 M37102、M37201、M37202、M37204、M37207 
M37515T-RPD 40 M38000 7515/3850/3851 群 
M37610T-RPD 2 M37600 7610 群 
M37640T-RPD 4 M37600 7640 群 
M37690T-RPD 1 M37600 7690 群 
M38749T-RPD 40 M38000 3874 群 

*4 仿真器 MCU 不存在的单片机除外。 
 

*3 MCU 信息序号 
MCU 信息序号必须参照下表进行记述： 

MCU 名 信息序号 
M3753x、M3754x 01 
M376xx 02 
上述 MCU 除外 00 

 
◆注意事项◆ 
对于新的 MCU，可能使用新的 POD 序号、固化软件名以及 MCU 信息序号。 
 

2.9.3.1 记述例 
举例如下： 

2 
3B 
FF 
FFFC 
0 
M38000 
00 
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第3章 设定调试对象目标信息 

调试对象目标信息的设定内容根据产品而不同。 
 

3.1 PD308 
在关闭了启动 PDxx 后打开的 Init 对话框后，打开 Emem 对话框。在 Emem 对话框设定调试对象目标。 
此对话框设定的内容在下次启动时也有效。 

 

为了在下次启动调试程序时不打开 Emem 对话框，请选定 Emem 对话框下部的 Next Hide 
Emem 对话框可通过在启动调试程序后选择菜单[Environment]→[Emem...]打开。 
 

3.1.1 调试监控程序的存储体指定 
必须分配调试监控程序（仿真器运行所必需的程序）使用的区域。 
使用从指定的存储体起始地址开始的 64K 字节。 
z 对于指定给调试监控程序的存储体，不能参照和设定其内容。 
z 不能指定和 SFR 区/内部 RAM 区/中断向量区重复的存储体。 
 

3.1.2 处理器模式的指定 
必须按照目标系统指定处理器模式。 
能指定以下任何一种模式： 
z Single-chip Mode 
z Memory Expansion Mode 
z Microprocessor Mode 
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3.1.3 仿真存储区和存储器映像的指定 
在此，指定仿真存储区（调试对象区）及其映像信息（最大 4 个区域）。 
仿真存储器的容量根据仿真 POD 而不同（请参照仿真 POD 的操作说明书）。 

Bank 指定调试对象存储体。如果指定 C0，C00000h 就为调试对象区的起始地址。 
Length 指定调试对象区的容量（256K 字节或者 1M 字节）。 
Map 指定区域的映像信息（Internal 或者 External）。不用时选择“No Use”。 

 
z 在 Map 选择了“No Use”的区域以及仿真存储器以外的区域被分配为 External 区域。对这些区域的目

标程序的下载速度低于指定为 External 的区域。 
z 在指定 Length 为“256KB”时，能给 Bank 指定 00、04、08、～FC（每 4 个存储体）；在指定 Length

为“1MB”时，能给 Bank 指定 00、10、20、～F0（每 16 个存储体）。 
z 调试对象区不能重复。 
z 指定的调试对象区的总容量不能超过使用的仿真 POD 的仿真存储器容量。 
 
仿真存储区的设定根据所指定的处理器模式而不同。 
 
z Single-chip Mode 

不必指定分配为仿真存储器的区域。 
FC0000h～FFFFFFh 的内部 ROM 区被自动分配为仿真存储器。 

z Memory Expansion Mode 
如果在 FC0000h～FFFFFFh 的内部 ROM 区之外有分配为仿真存储器的区域，就必须分别指定。 
FC0000h～FFFFFFh 的内部 ROM 区被自动分配为仿真存储器。 

z Microprocessor Mode 
必须分别指定分配的区域（没有自动分配的区域）。 

 
◆注意事项◆ 
z 用 Map 命令设定的映像设定不反映到 Emem 对话框。 
z 必须从使用的区域按顺序设定仿真存储区。 

用 Map 命令设定的仿真存储区号忽视未使用（Not Use）区进行仿真存储区号的分配。其结果将发生在

Emem 对话框设定的仿真存储区和用 Map 命令设定的仿真存储区的序号不一致。 
 

3.2 PD30 

3.2.1 存储器映像信息的设定 
存储器映像的设定如下： 

区域 映像 备注 
SFR External  
内部 RAM Internal  
内部 ROM Internal  
外部 ROM External 只限于存储器扩展模式和微处理器模式 

 
在改变存储器映像时必须使用 MAP 命令。 
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◆补充事项◆ 
z 仿真器将 FFFCh～FFFFh 临时用作堆栈，此区域必须设定为 Internal。 

在设定为 External 时，必须给此区域准备可读写存储器。 
z 在 M16C/62 系列的单片机使用存储器空间扩展功能时，地址重复的区域必须设定为 External（重复的区

域根据存储器而不同）。 
·存储器空间扩展模式 1：4000h～2FFFFh 
·存储器空间扩展模式 2：40000h～BFFFFh 

 

3.3 PD79 和 PD77 
在关闭了启动 PDxx 后打开的 Init 对话框后，打开 Emem 对话框。在 Emem 对话框设定调试对象目标。 
此对话框设定的内容在下次启动时也有效。 

 

 
选项卡名 内容 

Processor 指定处理器模式。 
EMEM 指定仿真存储区。 
ROM 指定仿真存储器内的 ROM 区。 
DMA 指定仿真存储器内的 DMA 传送区。 
8bit 指定在仿真存储器内以 8 位模式存取的区域（只限于 PD79）。 
MAP 指定存储器映像。 
Debug Monitor 指定调试监控程序的存储体和调试监控程序的工作地址。 
Flash Clear 指定在下载时是否清除 MCU 内部闪存的内容（只限于 PD79）。 

 
为了在下次启动调试程序时不打开 Emem 对话框，请选定 Emem 对话框下部的 Next Hide。 
Emem 对话框可通过在启动调试程序后选择菜单[Environment]→[Emem...]打开。 
 

3.3.1 Processor 选项卡 
指定处理器模式。 
指定的内容在下次启动时也有效。 
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3.3.1.1 处理器模式的选择 
选择目标系统的处理器模式。可选择以下任何一种模式： 
z 单芯片模式 
z 16 位存储器扩展模式 
z 8 位存储器扩展模式 
z 16 位微处理器模式 
z 8 位微处理器模式 
 
在选择的处理器模式与实际的目标系统不一致时，显示错误信息。 
此时，以选择的处理器模式开始调试。 
 
在处理器模式选择单选按钮的下面显示和目标系统相关的管脚状态。 
z PD79 

·BYTE 管脚 
·MD0 管脚 

z PD77 
·BYTE 管脚 
·CNVSS 管脚 

 

3.3.2 EMEM 选项卡 
指定仿真存储区。 
指定的内容在下次启动时也有效。 
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3.3.2.1 仿真存储区的设定 
设定仿真存储区（调试对象区）。 
仿真存储器能以 1 个存储体（64K 字节）为单位分配。 
仿真器具有 256K 字节（4 个存储体）＋1M 字节（16 个存储体）的仿真存储区。 
最初的 256K 字节被分配为存储体 0～存储体 3（000000h～03FFFFh）（不能改变）。 
对于后面的 1M 字节，请指定任意的调试对象区（最大 16 个存储体）。 
没有分配仿真存储区的区域不能使用以下功能： 
z 设定/解除软件暂停 
z 设定/解除存储器映像 
z 设定/参照 DMA 传送区 
 

＜＜仿真存储区的追加＞＞ 
单击 Add 按钮，打开对话框。 

 

指定调试对象存储体的起始地址和结束地址。 
指定的存储体地址将被显示在列表框。 
 

＜＜仿真存储区的解除＞＞ 
在列表框单击要解除的区域后，单击 Del 按钮。 
与删除的区域对应的 ROM 区、DMA 区、8 位总线模式区（只限于 PD79）的设定也同时被删除。 
 
◆补充事项◆ 
外部设备的地址和仿真存储区的地址重复时的运行取决于存储器映像的设定。 
在要将外部设备置为有效时必须设定成 External，在要将仿真存储器置为有效时必须设定成 Internal。 
必须通过 Emem 对话框的 MAP 选项卡或者 Map 命令进行存储器映像的设定。 
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3.3.3 ROM 选项卡 
指定仿真存储器内的 ROM 区。 
指定的内容在下次启动时也有效。 

 

 

3.3.3.1 ROM 区的设定 
设定仿真存储区内的 ROM 区（禁止用户程序写的区域）。 
通过指定 ROM 区，能禁止对该区域的写操作 
能指定为 ROM 区的区域限于存储体 0～存储体 3（000000h～03FFFFh）和 Emem 对话框的 EMEM 选项卡

设定的任意 16 个存储体。 
另外，能指定的 ROM 区最大为 10 个。 
 

＜＜ROM 区的追加＞＞ 
单击 Add 按钮，打开对话框。 

 

指定起始地址和结束地址。 
指定区域将被显示在列表框。 
如果指定的地址范围跨越存储体，就被分割成各个存储体。 
 

＜＜ROM 区的解除＞＞ 
在列表框单击要解除的区域后，单击 Del 按钮。 
 

3.3.4 DMA 选项卡 
指定仿真存储器内的 DMA 传送区。 
指定的内容在下次启动时也有效。 
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3.3.4.1 DMA 传送区的设定 
设定仿真存储器区内的 DMA 传送区（传送源和传送目标）。 
如果不指定 DMA 传送区，就不能在该区域的 DMA 传送中进行 1 总线传送（可以进行 2 总线传送）。 
能指定为 DMA 传送区的区域限于存储体 0～存储体 3（000000h～03FFFFh）和 Emem 对话框的 EMEM 选

项卡设定的任意 16 个存储体。 
另外，能指定的 DMA 传送区最大为 1024 个。 
 

＜＜DMA 传送区的追加＞＞ 
单击 Add 按钮，打开对话框。 

 

指定起始地址和结束地址。 
指定区域将被显示在列表框。 
如果指定的地址范围跨越存储体，就被分割成各个存储体。 
 

＜＜DMA 传送区的解除＞＞ 
在列表框单击要解除的区域后，单击 Del 按钮。 
 

3.3.5 8bit 选项卡 
指定在仿真存储器内以 8 位模式存取的区域。 
只有 PD79 支持此选项。指定的内容在下次启动时也有效。 
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3.3.5.1 8 位总线模式区的设定 
设定在仿真存储区内以 8 位总线模式存取的区域。 
如果不指定 8 位总线模式区，就不能对该区域进行 8 位总线模式的存取。 
能指定 8 位总线模式区的区域限于存储体 0～存储体 3（000000h～03FFFFh）和 Emem 对话框的 EMEM 选

项卡设定的任意 16 个存储体。 
另外，能指定的 8 位总线模式区最大为 1024 个。 
 

＜＜8 位总线模式区的追加＞＞ 
单击 Add 按钮，打开对话框。 

 

指定起始地址和结束地址。 
指定区域将被显示在列表框。 
如果指定的地址范围跨越存储体，就被分割成各个存储体。 
 

＜＜8 位总线模式区的解除＞＞ 
在列表框单击要解除的区域后，单击 Del 按钮。 
 

3.3.6 MAP 选项卡 
指定存储器映像。 
指定的内容在下次启动时也有效。 
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3.3.6.1 存储器映像的设定 
设定仿真存储区的存储器映像。 
如果选择 Internal，仿真存储器就为有效；如果选择 External，外部设备就为有效。 
能指定存储器映像的区域限于存储体 0～存储体 3（000000h～03FFFFh）和 Emem 对话框的 EMEM 选项卡

设定的任意 16 个存储体。 
另外，存储器映像区最大为 1024 个。 
 
存储器映像的默认值根据处理器模式而不同。 
如果改变处理器模式或者重新设定仿真存储区，存储器映像就变为以下的默认值状态： 

处理器模式 存储器映像 
单芯片 全区域被设定为 External。不能设定闪存区。 
存储器扩展 SFR 区和内部 RAM 区被设定为 External，其它的区域被设定为 Internal。

不能设定闪存区。 
微处理器 SFR 区和内部 RAM 区被设定为 External，其它的区域被设定为 Internal。

 
对于存储体 0～存储体 3，如果映像信息为 Internal，则仿真存储器有效；如果为 External，则外部设备有效。 
对于存储体 4～存储体 FF，如果分配了仿真存储器，就和存储体 0～存储体 3 相同处理，如果没有分配，

则外部设备有效。 
 

＜＜存储器映像的改变＞＞ 
单击 Set 按钮，打开对话框。 
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指定起始地址、结束地址以及映像（Internal 或者 External）。 
如果指定的地址范围跨越存储体，就被分割成各个存储体。 
在处理器模式为单芯片模式或者存储器扩展模式时，不能指定闪存区。 
 

3.3.7 Debug Monitor 选项卡 
指定调试监控程序的存储体和调试监控程序的工作地址。 
指定的内容在下次启动时也有效。 

 

 

3.3.7.1 调试监控程序的存储体设定（只限于 PD77） 
将目标程序的未使用存储体设定为调试监控程序的存储体。 
默认值的调试监控程序存储体为 FFh。 
不能将存储体 0～存储体 3（000000h～03FFFFh）和 Emem 对话框的 EMEM 选项卡设定的仿真存储区的存

储体指定为调试监控程序的存储体。 
另外，不能对指定的调试监控程序存储体进行存取（读/写）。 
 

＜＜调试监控程序的存储体改变＞＞ 
单击 Bank 按钮，打开对话框。 

 

指定调试监控程序的存储体。 
 

3.3.7.2 调试监控程序的工作地址设定（只限于 PD77） 
将目标程序的未使用区设定为调试监控程序的工作地址。 
仿真器将从设定的调试监控程序工作地址开始的 6 字节用作调试监控程序工作区（此区域不能在目标程序

中使用）。默认值的调试监控程序工作地址为 F000h。 
不能将 MCU 的内部资源（SFR 区、内部 RAM 区、中断向量区）指定为调试监控程序工作区。 
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＜＜调试监控程序工作区的改变＞＞ 
单击 Work Address 按钮，打开对话框。 

 

指定调试监控程序工作地址的起始地址。 
 

3.3.7.3 监视定时器的允许/禁止 
能允许/禁止使用监视定时器。默认值为禁止使用监视定时器。 
要允许使用监视定时器时，必须选定 WatchDog Timer Interrupt Enable 复选框。 
除了使目标程序自由运行以外，必须禁止使用监视定时器。 
 

3.3.8 Flash Clear 选项卡（只限于 PD79） 
指定在下载目标程序时是否清除 MCU 内部闪存的内容。 
指定的内容在下次启动时也有效。 

 

 
＜＜MCU 内部闪存清除的设定＞＞ 

请指定在下载目标程序时是否清除 MCU 内部闪存的内容。 
在列表视窗中以块单位显示 MCU 内部闪存。 
z 对于带有选定标记的块，在下载时不清除闪存的内容。在下载中不被重写的存储器内容维持原状。 
z 对于解除选定标记的块，在下载时清除闪存的内容。 
z 如果按下 All Append 按钮，在下载时就不清除全部块。 
z 如果按下 All Clear 按钮，在下载时就清除全部块。 
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3.4 PD38 

3.4.1 存储器映像信息的设定 
存储器映像的设定如下: 

区域 映像 备注 
SFR External  
RAM External  
内部 ROM Internal  
外部 ROM External 只限存储器扩展模式和微处理器模式 

 
在改变存储器映像时必须使用 MAP 命令。 
 
◆补充事项◆ 
z 如果调试对象单片机的RAM容量大于仿真器MCU的RAM容量，即使是RAM区也需要设定为 Internal。 

 
例）调试对象单片机 M38199MF 

单片机 M38199MF 持有 2K 字节（40h～83Fh）的 RAM。但是，对应的仿真器 MCU M38197RFS
只有 1K 字节（40h～43Fh）的 RAM。 

 
必须将仿真器 MCU 不持有的 RAM 区的存储器映像设定为 Internal。 
由于设定成 Internal，将存取仿真 POD 上的存储空间。 

>map 440,83f,internal<Enter> 
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第4章 设定调试程序的环境 

在 Customize 对话框进行调试程序的环境设定。 
通过选择菜单[Environment]→[Customize...]打开此对话框。 
在此对话框设定的内容在下次启动时也有效。 

 

 
选项卡名 内容 

ShortcutKey ·注册菜单的快捷键。 
Download ·设定在更新装入模块时的自动下载。 

·设定装入模块的下载履历数。 
Font ·指定使用的字体。 

·指定在源文件显示窗口中制表符的显示宽度。 
Path ·设定源文件的检索路径。 

·指定各种信息文件的保存目录。 
Tool Entry ·指定要启动的 Make 文件。 

·注册使用的编辑程序。 
Other ·设定在结束时不打开结束确认对话框。 

·设定在通信错误发生时不強制结束。 
·设定在调试程序结束时继续执行目标程序。 
·设定带绝对路径的源文件名的显示。 
·控制改变程序窗口的显示模式。 
·指定脚本命令的执行履历数。 

 
另外，能自定义显示在工具栏的按钮。 
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4.1 ShortcutKey 选项卡 
指定的内容在下次启动时也有效。 

 

 

4.1.1 注册菜单的快捷键 
能将各菜单注册到快捷键。 
也能将执行脚本文件或打开自定义窗口注册到快捷键。 
z 能分配的快捷键为 1 个任意键*或者 Shift/Ctrl/Alt 键的组合+ 1 个任意键*。 

* 1 个任意键是指以下的按键： 
·字母键 
·数字键 
·功能键 
·符号键（“,”、“@”、“:”等） 

z 如果快捷键信息有变，就在 Customize 对话框结束时（单击 OK 按钮时）显示以下的对话框，确认是否

保存改变的内容。 

 

如果保存改变的内容，就在下次启动 PDxx 时自动读其保存的内容。 
 

＜＜Shortcut Key 选项卡的说明＞＞ 
Key Assign 群 

Category 组合框 
显示菜单的种类。在所选种类内的有效菜单将被显示在 Menu List 列表框中。 
·种类名[Main Menu]指除各窗口的选项菜单以外的全部菜单。 
·如果选择窗口名的种类，则在该窗口内的有效选项菜单为有效。 
·如果选择种类名[Custom Window]，则已注册的自定义窗口为有效。 



第 4 章  设定调试程序的环境 

Rev.1.00 2005.02.18 page 39 of 132 
RCJ10J0010-0100 

 

·如果选择种类名[Script Command]，则已注册的脚本命令为有效。 
 

Menu List 列表框 
显示在 Category 组合框选择的菜单种类内的有效菜单。显示按字母顺序排列。 

 
Key 编辑框 

对在 Menu List 列表框选择的菜单，指定分配的快捷键。 
 

Current Key Assign 列表框 
对在 Menu List 列表框选择的菜单，显示已分配的快捷键。 

 
ADD 按钮 

将在 Key 编辑框指定的快捷键置为有效。 
 

DEL 按钮 
将在 Current Key Assign 列表框选择的快捷键置为无效。 

 
Current Shortcut Key List 群 

显示已设定的快捷键一览表。 
 
SAVE 按钮 

将在 Current Shortcut Key List 群显示的快捷键信息保存到文件。 
 
LOAD 按钮 

从文件读取快捷键信息。 
 
SCR 按钮 

给快捷键注册分配的脚本文件。 
 
CB 按钮 

给快捷键注册分配的自定义窗口。 
 

＜＜快捷键的注册＞＞ 
1. 在 Key Assign 群的 Category 组合框选择要注册的菜单种类。 

在 Menu List 列表框将显示该种类内的有效菜单。 
2. 在 Menu List 列表框选择要注册的菜单后，单击 Key 编辑框。 

进入快捷键的输入等待状态。 
3. 按下分配的快捷键。在 Key 编辑框将显示该快捷键的内容。 
4. 单击 Current Key Assign 列表框下的 ADD 按钮。 
 

＜＜快捷键的删除＞＞ 
1. 用以下的任何一种方法选择要删除的快捷键： 

·从 Current Shortcut Key List 群显示的一览表中选择。 
·从 Key Assign 群的 Menu List 列表框中选择。 

2. 单击 Current Shortcut Key List 群的 DEL 按钮。 
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＜＜快捷键的保存/读＞＞ 

在分别使用（保存/读）已分配的快捷键信息时，需要指定文件。 
单击 SAVE 键，指定文件名。 
要读取快捷键信息时，单击 LOAD 按钮，指定文件名。 
现在为止被注册的快捷键信息将全部删除。 
 
◆注意事项◆ 
z 不能将同一个快捷键分配给多个菜单。如果注册已被分配的键，就重写现在为止已被分配的快捷键信息。 
z 快捷键只对激活窗口有效。但是，即使重复打开相同的窗口，也不被反映在所有窗口。 
z 在窗口之间存在相同菜单（改变字体等）时，包括该菜单的全部窗口都变为有效。 
 

4.2 Download 选项卡 
指定的内容在下次启动时也有效。 

 

 

4.2.1 装入模块更新时自动下载的设定 
在由重新编译汇编更新下载的装入模块时，能自动下载该文件。 
在目标程序的执行操作（Go,Step 等）时更新。 
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必须在 Auto Download 群选择以下任何一个（默认值为“Disable”）。 
Enable（with confirmation） 在自动下载时要求确认。 
Enable（without confirmation） 在自动下载时不要求确认。 
Disable 不自动下载装入模块文件。 

 

4.2.2 装入模块下载履历数的设定 
能设定装入模块的下载履历数（默认值为 4 个）。 

 

在 File History 群的 File History Number 域指定履历数。能指定的值为 1 至 16。 
 

4.3 Font 选项卡 
指定的内容在下次启动时也有效。 
 

4.3.1 使用字体的指定 
能指定各窗口的默认值字体。 

 

要改变字体时，单击“Font...”按钮，打开字体指定对话框。 
指定字体和字体大小。 
 
◆补充事项◆ 
能按各窗口设定显示字体。 
在对象窗口为激活状态下选择菜单[Option]→[Font]，打开字体指定对话框。 
 

4.3.2 源文件显示的制表符指定 
能指定在显示源文件的窗口（程序窗口、覆盖源窗口等）中制表符的显示宽度。 

 

要改变制表符宽度时，直接给 TAB 域指定制表符宽度。能指定 1～32 的数值。 
 
◆补充事项◆ 
能按各窗口设定制表符宽度。 
在对象窗口为激活状态下选择 PDxx 窗口的菜单[Option]→[TAB]，打开 TAB 指定对话框。 
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4.4 Path 选项卡 
指定的内容在下次启动时也有效。 

 

 

4.4.1 源文件的检索路径设定 
能指定在程序窗口等显示的源文件的目录位置（检索路径）。 
当源文件不存在当前目录或者被分在多个目录时有效。 

 

要注册检索路径时，单击 File Search Path 群的 Add...按钮，打开文件夹选择对话框。 
指定源文件的所在目录。 
要删除检索路径时，单击要删除的检索路径，然后单击 Delete 按钮。 
要删除全部检索路径时，单击 Delete All 按钮。 
 

4.4.2 各种信息文件的保存目录指定 
能指定 ASM/C 监视点信息文件和其它信息文件的保存目录。 
其它文件指如下的文件： 
z 脚本命令的执行履历文件 
z 各种暂停信息文件等 
 
ASM/C 监视点信息文件的默认值保存目录为装入模块的所在目录。 
其它信息文件的默认值保存目录为安装 PDxx 的目录（例：c:\mtool\pdxx）。 
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要改变ASM/C监视点信息文件的保存目录时，解除Directory Setting群的Use the same directry as the absolute 
module file.复选框的选定。 

Watch Points:域有效。 
单击 Watch Points:域右边的 Refer...按钮，然后从目录选择对话框指定保存目录。 
 
要改变其它信息文件的保存目录时，单击 Other Settings:域右边的 Refer...按钮，然后从目录选择对话框指定

保存目录。 
 

4.5 Tool Entry 选项卡 
指定的内容在下次启动时也有效。 
 

4.5.1 Make 文件的启动 
首先必须准备好用于启动 Make 文件的 PIF 文件。 
有关 PIF 文件的建立方法请参照，“4.5.1.1  PIF 文件的建立方法”。 

 

单击 Make 群的 Refer 按钮，打开目录选择对话框。 
指定 Make 文件的所在目录。 
给 PIF Filename 域将指定要注册的 PIF 文件名。 
 

4.5.1.1 PIF 文件的建立方法 
1. 使用资源管理器等建立 command.com 的快捷方式（PIF 文件）。 

在 Windows Me/98/95 的情况下，command.com 存在于 Windows 目录中，在 Windows XP/2000/NT4.0
的情况下，command.com 存在于 Windows 目录下的 system32 目录中（例：\winnt\system32）。 

2. 将该 PIF 文件移动到要执行的目录下。 
3. 打开 PIF 文件的属性对话框，输入用于启动 Make 文件的命令行。 
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4.5.2 编辑程序的指定 
能从显示源文件的窗口（程序窗口、覆盖源窗口等）启动编辑程序。 

 

单击 Editor 群的 Refer 按钮，打开文件选择对话框。 
指定要使用的编辑程序的事项文件。 
 
给 Argument 域指定编辑程序的参数。 
“%F”为保存文件名，“%L”为保存行序号。 
有关编辑程序的选项指定，请参照编辑程序的手册/帮助。 
 

4.6 Other 选项卡 
指定的内容在下次启动时也有效。 
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4.6.1 结束确认对话框的打开控制 
能设定在调试程序结束时不打开结束确认对话框（默认值为打开）。 

 

要设定为不打开时，解除 Exit 群的上面复选框的选定。 
 

4.6.2 发生错误时的调试程序強制结束 
能设定在发生通信错误时不強制结束调试程序（默认值为強制结束）。 

 

要设定为不強制结束时，解除 Exit 群的上面复选框的选定。 
 

4.6.3 调试程序结束时的目标继续执行 
能选择在目标程序执行中结束调试程序时是继续还是停止执行（默认值为停止执行）。 

 

要继续执行时，解除 Exit 群的上面复选框的选定。 
 
◆注意事项◆ 
在下次启动调试程序时，不能再次控制继续执行过的目标程序。 
在下次启动调试程序时，按仿真器的系统复位开关对目标进行复位。 
 

4.6.4 重复启动的允许 
允许重复启动 PDxx（默认值为禁止重复启动）。 

 

要允许重复启动时，选定 Exit 群的上面复选框。 
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4.6.5 带绝对路径的源文件名显示 
在程序（源）窗口的标题栏以带绝对路径显示文件名时，能将该绝对路径置为非显示。 

 

要将文件名的绝对路径置为非显示时，选定 Other Setting 群的上面复选框。 
 

4.6.6 程序窗口的显示模式转换控制 
能在程序窗口控制（不改变现在的显示模式）在目标程序停止时的显示模式转换（根据停止位置显示模式

可以转换）。 

 

要控制显示模式时，选定上面复选框。 
 

4.6.7 脚本命令的执行履历 
能保留脚本命令的执行履历（默认值为保留 10 个履历）。 

 

要将脚本命令的执行履历设定为非保留时，解除上面复选框的选定。 
要改变执行履历数时，在 Number of Commands 域指定履历数（0～100）。 
 

4.6.8 源文件的更新警告 
如果在建立目标程序后有被更新的源文件，就能在发行目标执行命令时显示警告对话框（默认值为有警告）。 

 

如果在此警告对话框选择“否”，就中断将要发行的目标执行命令。创建和下载目标程序。 
如果选择“是”，就继续处理将要发行的目标执行命令。从下次开始（到进行下一次的下载处理为止）即

使发行目标执行命令也不显示警告。 
另外，如果在此警告对话框选定 Next Hide 复选框后关闭对话框，就从下次开始不进行源文件的更新警告（和

解除 Warn to update the target program 复选框的选定相同）。 
 

4.7 工具栏的自定义 
能自定义各窗口工具栏的按钮。自定义时，在窗口的工具栏上单击鼠标的右键，打开以下的弹出式菜单。 
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Flat style 如果选定，按钮就变平。 
Text labels 如果选定，就在按钮的下面显示文本。 
Labels on right side 如果选定，就在按钮的右边显示文本。 
Customize… 打开工具栏自定义对话框。 

 

4.7.1 工具栏的按钮配置 
如果在窗口的工具栏选择「Customize…」或者双击没有配置按钮的区域，就打开工具栏自定义对话框。 

 

z 已备有对应窗口的各选项菜单的按钮。 
z 能追加的按钮限于各窗口能使用的按钮，不能追加其它窗口的按钮。 
 

4.7.1.1 按钮的追加 
在工具栏自定义对话框右侧的“能利用的按钮”列表框单击要追加的按钮，然后单击对话框中央的“追加”

按钮。 
 

4.7.1.2 按钮的删除 
在工具栏自定义对话框左侧的“工具栏的按钮”列表框单击要删除的按钮，然后单击对话框中央的“删除”

按钮。 
 

4.7.1.3 改变按钮的显示顺序 
使用对话框右部的“上”按钮/“下”按钮改变显示顺序。在工具栏自定义对话框左侧的“工具栏的按钮”

列表框单击要改变的按钮，然后单击“上”按钮/“下”按钮改变显示位置。 
 

4.7.1.4 显示按钮的复位 
单击对话框右部的“复位”按钮，显示按钮恢复到默认值状态。 
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第5章 结束调试程序 

在结束调试程序时，选择菜单[File]→[Exit]，打开以下的对话框。 
 

 

单击“OK”按钮，结束调试程序。 
也能将结束确认的对话框设定为不打开。 
在设定为不打开时，请参照“4.6.1 结束确认对话框的打开控制”。 
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第1章 窗口一览 

z 窗口一览表 
本调试程序的窗口如下所示： 

窗口名 PC4701U/M/HS PC4701L 
PDxx 窗口 ○ 
程序窗口 ○ 
源窗口 ○ 
寄存器窗口 ○ 
存储器窗口 ○ 
转储窗口 ○ 
RAM 监控窗口 ○ 
ASM 监视窗口 ○ 
C 监视窗口 ○ 
局部窗口 ○ 
文件局部窗口 ○ 
全局窗口 ○ 
调用堆栈窗口

*1 ○ 
脚本窗口 ○ 
保护窗口 ○ × 
硬件暂停设定窗口 ○ × 
跟踪点设定窗口 ○ × 
跟踪窗口 ○ × 
覆盖窗口 ○ × 
区间时间测量窗口 ○ × 
MR 窗口*1 ○ 
MR 跟踪窗口*1, *2 ○ × 
MR 解析窗口*1, *2 ○ × 
MR 任务暂停窗口*1, *2 ○ 
Task 跟踪窗口 ○ × 
Task 解析窗口 ○ × 
GUI 输入窗口 ○ 
GUI 输出窗口 ○ 

*1  PD38（SIM）不支持。 
*2  PD79、PD77 不支持。 

 
z 主要对话框一览表 
本调试程序的主要对话框如下所示： 

主要对话框 PC4701U/M/HS PC4701L 
S/W 断点设定对话框 ○ 
H/W 断点设定对话框[PC4701L] × ○ 
芯片断点设定对话框*3 ○ 

*3  只有 PD79 支持 
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1.1 PDxx 窗口 
PDxx 窗口是控制 PDxx 全体的窗口，各窗口都从此窗口打开。 
 

1.1.1 窗口的结构 
在 PDxx 窗口内显示 PDxx 的各窗口。 
 

 

z 目标程序的执行/停止以及逐步执行等主要命令被配置在工具栏。 
z Option 菜单是取决于激活窗口的菜单。 

如果改变激活窗口，菜单的内容就自动改变。 
z PDxx 窗口下部的状态栏显示以下的信息： 

·各菜单/按钮的说明 
·目标程序从执行到停止的执行时间 
·目标程序的执行状况（在执行中或者在停止中） 
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1.1.2 窗口的工具栏 
本调试程序将基本的调试操作配置在工具栏。 

按钮 按钮名 内  容 

 
Go 从当前 PC 位置开始执行程序。 

 
Come 将程序从当前 PC 位置开始执行到窗口的光标位置所指示的地址。 

 
Step 从当前 PC 位置开始逐步执行。 

 
Over 从当前 PC 位置开始跨步执行。 

 
Return 从当前 PC 位置开始执行到上层程序。 

 
Stop 停止程序的执行。 

 
Break 将窗口的光标位置设定为软件断点。 

 
Reset 对程序进行复位。 

 
SW 打开 S/W 断点设定对话框。 

 
HW 打开 H/W 断点设定对话框。 

 
CB 打开芯片断点参照/删除对话框（只限于 PD79）。 

 

1.1.3 窗口的选项 
PDxx 窗口提供以下菜单： 
 
文件操作关联 

菜单 菜单项目 功  能 
Download 

Load Module... 
Memory Image... 
Symbol... 
Rom Data... 

下载目标程序 
下载机器语言数据和调试信息 
只下载机器语言数据 
只下载调试信息 
追加下载机器语言数据 

Reload... 重新下载目标程序 
Upload... 加载目标程序 
Save Disasm... 保存反汇编结果 
（Download File） 显示下载履历。 

File 

Exit 结束本调试程序 
 

编辑关联 

菜单 菜单项目 功  能 
Copy 将选择的字符串复制到剪贴板 
Paste 粘贴剪贴板的字符串 
Cut 删除选择的字符串并复制到剪贴板 
Delete 删除选择的字符串 
Undo 编辑的还原 

Edit 

Find… 检索字符串 
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显示关联 

菜单 菜单项目 功  能 
Tool Bar 转换工具栏的显示/非显示 
Status Bar 转换状态栏的显示/非显示 

View 

Tool Bar（Child） 转换工具栏（子窗口）的显示/非显示 

 

环境设定关联 

菜单 菜单项目 功  能 
Init… 环境设定（打开 Init 对话框） 
Start Up… 指定启动函数 

Environment 

Customize… 打开自定义对话框 

 

调试操作关联（基本调试） 

菜单 菜单项目 功  能 
Go 

Go 
Go Option... 

执行目标程序 
从当前 PC 开始执行 
从指定地址开始执行 

GoFree 目标程序的自由运行 
Come 执行到光标位置为止 
Step 

Step 
Step Option... 

逐步执行 
单步执行 
指定步数的执行 

Over 
Over 
Over Option… 

跨步执行 
单跨步执行 
指定步数的跨步执行 

Return 执行到当前子程序的返回为止 
Reset 对目标程序进行复位 
Stop 停止目标程序的执行 
Break Point 

S/W Break Point... 
H/W Break Point... 
Chip Break Point...* 
Break 
CB...* 

设定断点 
打开 S/W 断点设定对话框 
打开 H/W 断点设定对话框 
打开芯片断点设定对话框 
设定/解除光标位置的软件断点 
打开芯片断点参照/删除对话框 

Trace Point... 设定跟踪点 
Scope... 打开作用域设定对话框 

Debug 

Make 建立目标程序 
* PD79 以外的产品没有此菜单。 

 

选项菜单关联 

菜单 菜单项目 功  能 
Option Option 菜单的内容取决于激活窗口。 

如果转换激活窗口，菜单的内容就自动改变。 
各窗口的菜单内容请参照各窗口的参考项目。 

 



第 1 章  窗口一览 

Rev.1.00 2005.02.18 page 57 of 132 
RCJ10J0010-0100 

 

窗口操作关联（基本窗口） 

菜单 菜单项目 功  能 
Cascade 重叠显示窗口 
Title 排列显示窗口 
Arrange Icon 排列图标 
Program Window 激活程序窗口 
Source Window 打开源窗口 
Register Window 打开寄存器窗口 
Memory Window 打开存储器窗口 
Dump Window 打开转储窗口 
RAM Monitor Window 打开 RAM 监控窗口 
ASM Watch Window 打开 ASM 窗口 
C Watch Windows 

C Watch Window 
Local Window 
File Local Window 
Globall Window 

打开对应 C 语言的窗口 
打开 C 监视窗口 
打开局部窗口 
打开文件局部窗口 
打开全局窗口 

Call Stack Window* 打开调用堆栈窗口 

Basic 
Windows 

Script Window 打开脚本窗口 
*  PD38 不支持。 

 

窗口操作关联（高功能窗口） 

菜单 菜单项目 功  能 
Protect Window 打开保护窗口 
H/W Break Point Setting Window 打开 H/W 断点设定窗口 
Trace Point Setting Window 打开跟踪点设定窗口 
Trace Window 打开跟踪窗口 
Coverage Window 打开覆盖窗口 
Time Measurement Window 打开区间时间测量窗口 
Realtime OS Windows 

MR Window* 
MR Trace Window* 
MR Analyze Window* 
MR Task Pause Window* 
Task Trace Window 
Task Analyze Window 

对应实时 OS 的窗口 
打开 MR 窗口 
打开 MR 跟踪窗口 
打开 MR 解析窗口 
打开 MR 任务暂停窗口 
打开 Task 跟踪窗口 
打开 Task 解析窗口 

GUI Windows 
GUI Input Window 
GUI Output Window 

打开 GUI 窗口 
打开 GUI 输入窗口 
打开 GUI 输出窗口 

Optional 
Windows 

Custom Windows 
Option 
（自定义窗口） 

打开自定义窗口 
注册自定义窗口 
显示已注册的自定义窗口名。 

*  有的产品不支持。 

 

帮助关联 

菜单 菜单项目 功  能 
Contents 显示帮助文件 
Active Window 显示激活窗口的帮助 

Help 

About... 显示调试程序的版本 
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1.2 程序窗口 

程序窗口总是显示与当前程序计数器位置相应的源文件，在启动时自动打开。程序计数器位置用黄色显示

背景色。能进行光标位置为止的执行、软件断点的设定/解除以及行汇编等。 

 

程序窗口有以下 3 种显示模式： 

z 源显示模式 

显示目标程序的源文件。 

z 反汇编显示模式 

显示目标程序的反汇编结果。 

z MIX 显示模式 

同时显示目标程序的源文件和该部分的反汇编结果。 

 

1.2.1 源显示模式的结构 

程序窗口的源显示模式有以下 2 种，能通过程序窗口的菜单进行转换。 

调试模式 

用于调试（执行/停止等）目标程序的模式。 

编辑模式 

用于编辑源文件的模式。 

 

程序窗口的源显示模式（调试模式）的结构如下： 

 

工具栏 程序计数器位置

程序显示区

断点显示区
地址显示区

行号显示区
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z 行号显示区和地址显示区能分别进行显示/非显示的转换。 

z 通过双击行号显示区，能更改要显示的源文件。 

z 通过双击地址显示区，能更改显示起始地址/显示起始行。 

z 通过单击（或双击）断点显示区，能设定/解除断点。 

z 如果在 C 语言变量上让鼠标光标静止一定时间（约 0.5sec），就弹出显示该变量的内容。 

z 通过拖动函数名后使用右击菜单，能显示该函数部分的源文件。 

z 通过拖动 C 语言变量后使用右击菜单，能将该变量注册为 C 监视点。 

z 通过拖动汇编程序符号后使用右击菜单，能将该符号注册为 ASM 监视点。 

z 通过编辑程序，能打开正在显示的源文件（需要注册编辑程序名）。 

z 通过选项的指定，能显示覆盖测量结果（默认值为非显示）。 

z 能对单击的位置进行行汇编。 

 

程序窗口的源显示模式（编辑模式）的结构如下： 
 

 

 

z 不显示行号显示区、地址显示区、断点显示区。 

z 使用右击菜单，转换为编辑模式专用。 

z 在 PDxx 窗口的状态栏显示光标位置的行号和列号。 
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1.2.2 MIX 显示模式的结构 

程序窗口的 MIX 显示模式的结构如下： 
 

工具栏

行号显示区

地址显示区

断点显示区
程序显示区目标码显示区

标号显示区

 

z 行号显示区、地址显示区和目标码显示区能分别进行显示/非显示的转换。 

z 通过双击行号显示区，能更改要显示的源文件。 

z 通过双击地址显示区，能更改显示起始地址/显示起始行。 

z 通过单击（或双击）断点显示区，能设定/解除断点。 

z 在目标码显示区和标号显示区之间以及在标号显示区和程序显示区之间，能用鼠标更改显示比例。 

z 通过编辑程序，能打开正在显示的源文件（需要注册编辑程序名）。 

z 通过选项的指定，能显示覆盖测量结果（默认值为非显示）。 

z 能将 MIX 显示的结果保存到文本文件。 

z 能对单击的位置进行行汇编。 

z 上下滚动以源程序行为单位进行。 
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1.2.3 反汇编显示模式的结构 

程序窗口的反汇编显示模式的结构如下： 

 

工具栏

程序显示区

标号显示区
目标码显示区

断点显示区

地址显示区
 

 

z 地址显示区和目标码显示区能分别进行显示/非显示的转换。 

z 通过双击地址显示区，能更改显示起始地址。 

z 通过单击（或双击）断点显示区，能设定/解除断点。 

z 在目标码显示区和标号显示区之间以及在标号显示区和程序显示区之间，能用鼠标更改显示比例。 

z 通过选项的指定，能显示覆盖测量结果（默认值为非显示）。 

z 能对单击的位置进行行汇编。 
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1.2.4 窗口的选项 

在程序窗口被激活时，程序窗口提供以下菜单（称为程序窗口选项）： 

 

菜单 菜单项目 功  能 
Font... 更改字体 
TAB... 设定源文件显示时的制表符 
Color... 更改显示颜色 
View 

Source... 
Address... 
Program Counter 

更改显示内容 
更改源文件/函数级的显示 
更改地址/行号级的显示 
更改对程序计数器位置的显示 

Mode 
Source Mode 
Mix Mode 
Disasm Mode 

更改显示模式 
更改为源显示模式 
更改为 MIX 显示模式 
更改为反汇编模式 

Layout 
Line Area 
Address Area 
Code Area 

布局设定 
转换行号显示区的显示/非显示 
转换地址显示区的显示/非显示 
转换目标码显示区的显示/非显示 

Line Assemble... 行汇编 
Save Mix… 保存 MIX 显示结果 
Coverage 

On/Off 
Base... 
Clear 
Refresh 

覆盖的显示设定 
转换测量结果的显示/非显示 
设定基址 
清除测量结果 
刷新测量结果 

Option 

Edit 
On 
Save 
Save As… 
Save All 

编辑功能 
进行可编辑/不可编辑的转换 
以重写方式保存编辑内容 
用别名保存编辑内容 
全部以重写方式保存编辑内容 

 

1.2.5 窗口的快捷方式菜单 

程序窗口提供在程序窗口内单击鼠标右键的快捷方式菜单（称为程序窗口右击菜单）。 

菜单内容根据单击的位置而不同。 

 

z 当右击行号显示区、地址显示区时 

显示和选项菜单相同的快捷方式菜单。 

z 当右击断点显示区时 

不显示快捷方式菜单，而设定硬件暂停。 

z 当右击其它区域时 

显示以下的快捷方式菜单。 
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调试模式 

菜单 菜单项目 功  能 
Jump to function 
Open Source Window 

显示选择的函数 
显示选择的函数（重新打开源窗口） 

Add C Watch... 
Add C Watch Pointer… 
Add ASM Watch… 
BitAdd ASM Watch… 

将选择的变量注册成 C 监视点 
将选择的指针变量注册成 C 监视点 
将选择的符号注册成 ASM 监视点 
将选择的位符号注册成 ASM 监视点 

Open Editor 
Line Assemble... 

打开编辑程序 
行汇编 

Save Mix… 保存 MIX 模式（只在 MIX 模式时显示） 

右击 

Edit 
On 

编辑源程序 
进行可编辑/不可编辑的转换（只在 SRC 模式时显示） 

 

编辑模式 

菜单 菜单项目 功  能 
Copy 和[Edit]->[Copy]菜单的功能相同 
Paste 和[Edit]->[Paste]菜单的功能相同 
Cut 
Delete 
Undo 

和[Edit]->[Cut]菜单的功能相同 
和[Edit]->[Delete]菜单的功能相同 
和[Edit]->[Undo]菜单的功能相同 

Find 和[Edit]->[Find]菜单的功能相同 
Font… 
Tab… 

和[Option]->[Font]菜单的功能相同 
和[Option]->[Tab]菜单的功能相同 

右击 

Edit 
On 
Save 
Save As… 
Save All 

源程序的编辑 
和[Option]->[Edit]->[On]菜单的功能相同 
和[Option]->[Edit]->[Save]菜单的功能相同 
和[Option]->[Edit]->[Save As]菜单的功能相同 
和[Option]->[Edit]->[Save All]菜单的功能相同 

 

1.3 源窗口 

源窗口是连续显示任意源文件位置的窗口（程序窗口总是显示与当前程序计数器位置对应的源文件）。 

当程序计数器与所显示的源文件位置对应时，用黄色显示背景色。 

和程序窗口同样能进行到光标位置的执行、软件断点的设定/解除以及行汇编等。 

源窗口最多能打开 30 个。 

 

1.3.1 窗口的结构 

 

有关源窗口的结构、选项等和程序窗口相同，请参照“1.2 程序窗口”。 
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1.4 寄存器窗口 

寄存器窗口是显示寄存器内容或者标志内容的窗口。 

能从窗口更改寄存器/标志的值。 

 

1.4.1 窗口的结构 

下图是用于 M16C/60、20 系列的调试程序 PD30（SIM）的寄存器窗口： 

 

 
 

z 如果寄存器/标志的值有更新，就用红色显示该值。 

z 通过双击寄存器显示行，打开要更改寄存器值的对话框。 

z 通过单击与标志对应的按钮，能转换标志的值。 

z 通过右击菜单，能更改各寄存器的显示基数以及进行寄存器存储体的转换等（寄存器存储体的转换只限

于 PD308（SIM）/PD30（SIM））。 

z 在寄存器名显示区和寄存器值显示区之间以及在寄存器值显示区和基数显示区之间，能用鼠标更改显示

比例。 

 

1.4.2 窗口的选项 

在寄存器窗口被激活时，寄存器窗口提供以下菜单（称为寄存器窗口选项）： 
 

菜单 菜单项目 功  能 
Bank0*1 
Bank1*1 

显示寄存器存储体 0 
显示寄存器存储体 1 

Hide DPR1-3*2 转换 DPR1、DPR2、DPR3 寄存器的显示/非显示 
Layout 

Hide Radix 
Hide FLAGs 

布局设定 
转换基数显示区的显示/非显示 
转换标志显示部的显示/非显示 

Option 

Font... 更改字体 
*1 只限于 PD308（SIM）/PD30（SIM） 

*2 只限于 PD79（SIM） 
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1.4.3 窗口的快捷方式菜单 

寄存器窗口提供在寄存器窗口内单击鼠标右键的快捷方式菜单（称为寄存器窗口右击菜单）。 
 

菜单 菜单项目 功  能 
Hex 
Dec 
Bin 

以 16 进制数显示寄存器值 
以 10 进制数显示寄存器值 
以 2 进制数显示寄存器值 

Bank0*1 显示寄存器存储体 0 
Bank1*1 显示寄存器存储体 1 
Hide DPR1-3*2 转换 DPR1、DPR2、DPR3 寄存器的显示/非显示 
Layout 

Hide Radix 
Hide FLAGs 

布局设定 
转换基数显示区的显示/非显示 
转换标志显示部的显示/非显示 

右击 

Font... 更改字体 
*1 只限于 PD308（SIM）/PD30（SIM） 

*2 只限于 PD79（SIM） 
 

1.5 存储器窗口 

存储器窗口是以[地址]、[标号]、[数据（存储器内容）]的格式显示连续的存储器内容的窗口。能从窗口

进行存储器内容的更改、指定区域的填充（Fill）/复制（Move）。 

存储器窗口最多能打开 30 个。 
 

1.5.1 窗口的结构 

 

工具栏

地址显示区

标号显示区

存储器内容显示区
 

z 显示数据能从 1 字节/2 字节/4 字节（PD38（SIM）不支持 4 字节单位的显示）、2 进制数/10 进制数/16
进制数/ASCII/SJIS/JIS 中选择（默认值为 1 字节、16 进制数显示）。 

z 通过在按下 Ctrl 键的状态下选择用于窗口打开的菜单，能指定显示起始地址。 

z 通过双击地址显示区，打开更改显示起始地址的对话框。 

z 通过双击标号显示区/存储器内容显示区，打开用于更改单击地址的存储器内容的对话框。 

z 具有高速显示的存储器高速缓存（默认值为高速缓存无效）。 
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z 在标号显示区和存储器内容显示区之间，能用鼠标更改显示比例。 

z 能跟踪栈指针的位置（默认值为无跟踪）。 
 

1.5.2 窗口的选项 

在存储器窗口被激活时，存储器窗口提供以下菜单（称为存储器窗口选项）： 
 

菜单 菜单项目 功  能 
Font 更改字体 
View 

Scroll Area... 
Address... 
（xxxxx）*1 
Followed Stack Pointer… 
Data Length 

Byte 
Word 
Lword*2 

Radix 
Bin 
Dec 
Hex 
ASCII 
SJIS 
JIS 

Refresh 

更改显示内容 
指定滚动范围 
指定显示起始地址 
（根据产品而不同） 
设定栈指针跟踪模式 
指定显示数据长度 
以 1 字节单位显示 
以 2 字节单位显示 
以 4 字节单位显示 

指定显示基数 
以 2 进制数显示 
以 10 进制数显示 
以 16 进制数显示 
以 ASCII 码显示 
以 SJIS 码显示 
以 JIS 码显示 

数据重新显示 
Debug 

Set... 
Fill... 
Move... 

指定存储器内容 
设定指定地址的数据 
填充指定区域的数据 
复制指定区域的数据 

Option 

Cache On 进行存储器高速缓存的 ON/OFF 转换 
 

1.5.3 窗口的快捷方式菜单 

存储器窗口提供在存储器窗口内单击鼠标右键的快捷方式菜单（称为存储器窗口右击菜单）。 
 

菜单 菜单项目 功  能 
Set... 
Fill... 
Move... 

设定指定地址的数据 
填充指定区域的数据 
复制指定区域的数据 

Byte 
Word 
Lword*2 

以 1 字节单位显示 
以 2 字节单位显示 
以 4 字节单位显示 

Radix 
Bin 
Dec 
Hex 
ASCII 
SJIS 
JIS 

指定显示基数 
以 2 进制数显示 
以 10 进制数显示 
以 16 进制数显示 
以 ASCII 码显示 
以 SJIS 码显示 
以 JIS 码显示 

Register 
（xxxxx）*1 
Followed Stack Pointer… 

 
（根据产品而不同） 
设定栈指针跟踪模式 

Refresh 数据重新显示 
Scroll Area... 指定滚动范围 

右击 

Font 更改字体 
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*1 取决于产品的菜单 

产品名 菜单项目 功能 
PD308(SIM), 
PD30(SIM) 

FB 
SB 
USP 
ISP 

显示 FB 寄存器位置 
显示 SB 寄存器位置 
显示 USP 寄存器位置 
显示 ISP 寄存器位置 

PD79(SIM) S 
DPR0 
DPR1 
DPR2 
DPR3 

显示堆栈位置 
显示 DPR0 寄存器位置 
显示 DPR1 寄存器位置 
显示 DPR2 寄存器位置 
显示 DPR3 寄存器位置 

PD77(SIM) S 
DPR 

显示堆栈位置 
显示 DPR 寄存器位置 

PD38(SIM) S 显示堆栈位置 
 

*2  PD38（SIM）不支持。PD79（SIM）/PD77（SIM）显示为“Dword”。 

 

1.6 转储窗口 

转储窗口是以转储格式显示连续的存储器内容的窗口。 

 

1.6.1 窗口的结构 

能从窗口简单地进行存储器内容的更改、指定区域的填充（Fill）/复制（Move）。主要操作按钮被配置在

工具栏。 

转储窗口最多能打开 30 个。 

 

工具栏

地址显示区 数据显示区 ASCII码显示区
 

z 显示数据能从 1 字节/2 字节/4 字节（PD38（SIM）不支持 4 字节单位的显示）、10 进制数/16 进制数

/ASCII/SJIS/JIS 中选择。默认值为 1 字节、16 进制数显示。 

z 通过在按下 Ctrl 键的状态下选择用于窗口打开的菜单，能指定显示起始地址。 

z 通过双击地址显示区，打开用于更改显示起始地址的对话框。 

z 通过双击数据显示区，打开用于更改单击地址的存储器内容的对话框。 

z 具有高速显示的存储器高速缓存（默认值为高速缓存无效）。 
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1.6.2 窗口的选项 

在转储窗口被激活时，转储窗口提供以下菜单（称为转储窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
View 

Scroll Area... 
Address... 
Data Length 

Byte 
Word 
Lword* 

Radix 
Dec 
Hex 
ASCII 
SJIS 
JIS 

Refresh 

更改显示内容 
指定滚动范围 
指定显示起始地址 
指定显示数据长度 
以 1 字节单位显示 
以 2 字节单位显示 
以 4 字节单位显示 

指定显示基数 
以 10 进制数显示 
以 16 进制数显示 
以 ASCII 码显示 
以 SJIS 码显示 
以 JIS 码显示 

数据重新显示 
Debug 

Set... 
Fill... 
Move... 

指定存储器内容 
设定指定地址的数据 
填充指定区域的数据 
复制指定区域的数据 

Option 

Cache On 存储器高速缓存的 ON/OFF 转换 

 

1.6.3 窗口的快捷方式菜单 

转储窗口提供在转储窗口内单击鼠标右键的快捷方式菜单（称为转储窗口右击菜单）。 

 

菜单 菜单项目 功  能 
Set... 
Fill... 
Move... 

设定指定地址的数据 
填充指定区域的数据 
复制指定区域的数据 

Byte 
Word 
Lword* 

以 1 字节单位显示 
以 2 字节单位显示 
以 4 字节单位显示 

Radix 
Dec 
Hex 
ASCII 
SJIS 
JIS 

指定显示基数 
以 10 进制数显示 
以 16 进制数显示 
以 ASCII 码显示 
以 SJIS 码显示 
以 JIS 码显示 

Refresh 数据重新显示 
Scroll Area... 指定滚动范围 

右击 

Font 更改字体 
 
*  PD38（SIM）不支持。PD79（SIM）/PD77（SIM）显示为“Dword”。 
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1.7 RAM 监控窗口 

RAM 监控窗口是以转储格式显示与 RAM 监控区域（连续 1K 字节）对应的存储器内容的窗口。 

在目标程序执行中以一定间隔（默认值为 100msec）更新显示内容。主要操作按钮被配置在工具栏。 

RAM 监控窗口最多能打开 10 个。 

 

1.7.1 窗口的结构 

工具栏

地址显示区 数据显示区 ASCII码显示区
Read（绿色） Write（红色）

更新间隔显示

 

z 默认值的 RAM 监控区为 0h～3FFh。通过单击 Area 按钮打开更改 RAM 监控区的对话框。 

z 通过双击地址显示区打开更改显示起始地址的对话框。如果指定的地址在 RAM 监控区以外，RAM 监

控区也被更改。 

z 在更新间隔显示区显示目标程序执行中的更新间隔（在目标停止中显示字符串 Address）。 

更新间隔根据运行状况（以下的因素）可能会慢于指定的更新间隔。 

·主机的性能 

·窗口的大小（存储器显示量） 

·值变化的存储器个数 

z 数据显示区和 ASCII 码显示区的背景色根据存取属性变化如下（无存取时背景色为白色）： 

·Read 存取的地址 
背景色变为绿色。 

·Write 存取的地址 
背景色变为红色。 

能通过选项的指定改变显示颜色。 

z 通过以下操作清除存取属性： 

·单击 Clear 按钮 

·下载目标程序 

z 显示数据能从 1 字节/2 字节/4 字节（PD38（SIM）不支持 4 字节单位的显示）、10 进制数/16 进制数

/ASCII/SJIS/JIS 中选择（默认值为 1 字节、16 进制数显示）。 
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◆注意事项◆ 

z RAM 监控取得总线存取的数据，不反映目标程序以外的存取变化。 

z 在 RAM 监控区的显示数据长不为 1 字节单位的情况下，对于此数据的各字节，存储器的存取属性可能

不同。如果在这样 1 个数据中存取属性不统一，就用括弧将该数据括起来显示。此时的背景色为该数据

的第 1 字节的存取属性的颜色。 

 

 

1.7.2 窗口的选项 

在 RAM 监控窗口被激活时，RAM 监控窗口提供以下菜单（称为 RAM 监控器窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
View 

Address... 
Data Length 

Byte 
Word 
Lword* 

Radix 
Dec 
Hex 
ASCII 
SJIS 
JIS 

Clear 

更改显示内容 
指定显示起始地址 
指定显示数据长度 
以 1 字节单位显示 
以 2 字节单位显示 
以 4 字节单位显示 

指定显示基数 
以 10 进制数显示 
以 16 进制数显示 
以 ASCII 码显示 
以 SJIS 码显示 
以 JIS 码显示 

清除存取属性 
Layout 

Ascii 
布局的指定 
转换 ASCII 码显示区的显示/非显示 

RAM Monitor Area... 设定 RAM 监控区 
Color... 设定存取属性的显示颜色 

Option 

Sampling period... 设定显示更新间隔 
 
*  PD38（SIM）不支持。PD79（SIM）/PD77（SIM）显示为“Dword”。 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 

 

1.8 ASM 监视窗口 

ASM 监视窗口是显示任意地址的存储器内容的窗口。显示时需要事前注册。 

如果指定的地址在 RAM 监控区内，就在目标程序执行中以一定间隔（默认值为 100msec）更新。 

主要操作按钮被配置在工具栏。 
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1.8.1 窗口的结构 

 

工具栏

地址/位显示区

地址表达式显示区

数据长显示区

基数显示区 数据显示区

 

z 将要参照的任意地址称为监视点。能注册以下任何一种： 

·地址（可用符号指定） 

·地址+位序号 

·位符号 

z 通过双击基数显示区，循环改变基数显示（Hex→Dec→Bin）。 

z 在关闭 ASM 监视窗口时已注册的监视点信息将被保存到环境设定文件，在重新打开时自动注册。 

z 如果给监视点指定符号/位符号，就在下载目标程序时重新计算地址表达式，并用新地址显示存储器内

容。 

z 无效的监视点显示为“--<not active>--”。 

z （使用拖放功能）能更改监视点的排序。 

 

◆注意事项◆ 

z RAM 监控取得总线存取的数据，不反映目标程序以外的存取的变化。 

z 在 RAM 监控区的显示数据长不为 1 字节单位的情况下，对于此数据的各字节，存储器的存取属性可能

不同。如果在这样 1 个数据中存取属性不统一，就不能正确显示该数据的存取属性。此时的背景色为该

数据的第 1 字节的存取属性的颜色。 
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1.8.2 窗口的选项 

在 ASM 监视窗口被激活时，ASM 监视窗口提供以下菜单（称为 ASM 监视窗口选项）： 
 

菜单 菜单项目 功  能 
Font 更改字体 
Watch 

Add... 
Bitadd... 
Set... 
Del 
Del All... 
Refresh 

注册/删除监视点 
注册地址级的监视点 
注册位级的监视点 
设定监视点的存储器内容 
删除监视点 
删除全部监视点 
数据重新显示 

Radix 
Bin 
Dec 
Hex 

更改显示基数 
以 2 进制数显示 
以 10 进制数显示 
以 16 进制数显示 

Layout 
Address Area 
Size Area 

布局设定 
转换地址/位显示区的显示/非显示 
转换数据长度显示区的显示/非显示 

RAM Monitor 
RAM Monitor Area... 
Color... 
Sampling period... 
Clear 

RAM 监控显示 
设定 RAM 监控区 
更改存取属性的显示颜色 
设定显示更新间隔 
清除存取属性 

Option 

File  
Save... 
Load... 

ASM 监视点的保存/读取 
保存 ASM 监视点 
读取 ASM 监视点 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 

 

1.9 C 监视窗口 

C 监视窗口是显示任意 C 语言表达式内容的窗口。显示时需要事前注册。 

能从窗口更改变量的内容。 

如果指定的地址在 RAM 监控区内，就在目标程序执行中以一定间隔（默认值为 100msec）更新。 
 

1.9.1 窗口的结构 

工具栏

变量类型 C语言
表达式

变量值
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z 将要参照的任意 C 语言表达式称为 C 监视点。能注册以下任何一种： 

·C 符号 

在 C 语言源程序中定义的变量名和函数名 

·C 语言表达式 

用计算式将 C 符号进行组合的表达式 

z 如果不能正确计算 C 语言表达式（C 符号未定义等），就注册为无效 C 监视点。显示“--<not active>--”。
如果能正确重新计算表达式，就变为有效 C 监视点。 

z 能按各 C 语言表达式更改显示基数（Hex→Dec→Bin）。 

z 指针等的地址显示与显示基数无关被固定成 16 进制显示。 

z 不能更改如下所示 C 监视点的值： 

·浮点型变量 

·位字段型变量 

·寄存器变量 

·不指向地址的 C 监视点（无效 C 监视点） 

z 在关闭 C 监视窗口时已注册的 C 监视点信息将被保存到 C 监视点信息文件，在重新打开时自动注册。 

按各装入的目标文件建立 C 监视点信息文件（包含目标文件名信息）。 

z （使用拖放功能）能更改 C 监视点的排序。 

 

◆注意事项◆ 

z RAM 监控取得总线存取的数据。不反映目标程序以外的存取的变化。 

z 在 RAM 监控区的显示数据长不为 1 字节单位的情况下，对 1 字节单位的数据存储器的存取属性可能不

同。如果在这样 1 个数据中存取属性不统一，就不能正确显示该数据的存取属性。此时的背景色为该数

据的第 1 字节的存取属性的颜色。 

 

1.9.2 窗口的选项 

在 C 监视窗口被激活时，C 监视窗口提供以下菜单（称为 C 监视窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
Watch 

Add 
Add Pointer 
Del 
Set... 
Cancel 
Del All… 

注册/删除 C 监视点 
注册 C 监视点 
注册 C 监视点（指针） 
删除 C 监视点 
设定 C 监视点的存储器内容 
解除 C 监视点的选择 
删除全部 C 监视点 

View 
Radix 
Layout 
Sort 
Display String 

更改显示内容 
更改显示基数 
转换变量类型名的显示/非显示 
按字母顺序排列 
转换文字显示/字符串显示 

RAM Monitor 
Enable 
RAM Monitor Area... 
Color... 
Sampling period... 

RAM 监控显示 
转换 RAM 监控功能的有效/无效 
设定 RAM 监控区 
更改存取属性的显示颜色 
设定显示更新间隔 

Option 

Clear 清除存取属性 
 
也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
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1.10 局部窗口 

局部窗口是显示函数内局部变量内容的窗口。能从窗口更改变量内容。 

 

1.10.1 窗口的结构 

变量类型 C语言
表达式

变量值

函数名 相应函数存在的文件名 工具栏

 

 

z 显示与程序计数器位置相应的函数的局部变量。 

通过逐步执行等操作，在相应函数有更改的情况下，自动显示更改后的局部变量。 

z 能将选择的 C 语言变量作为 C 监视点注册到 C 监视窗口。 

z 指针等的地址显示与显示基数无关被固定成 16 进制显示。 

z 能按各 C 语言变量更改显示基数（Hex→Dec→Bin）。 

 

1.10.2 窗口的选项 

在局部窗口被激活时，局部窗口提供以下菜单（称为局部窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
Watch 

Cwatch 
CWatch Pointer 
Set... 

注册/删除 C 监视点 
作为 C 监视点进行注册 
作为 C 监视点进行注册（指针） 
设定 C 语言变量的存储器内容 

Cancel 解除 C 语言变量的选择 

Option 

View 
Radix 
Layout 
Sort 
Display String 

更改显示内容 
更改显示基数 
转换变量类型名的显示/非显示 
按字母顺序排列 
转换文字显示/字符串显示 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
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1.11 文件局部窗口 

文件局部窗口是显示文件内局部变量内容的窗口。能从窗口更改变量内容。 

如果指定的地址在 RAM 监控区内，就在目标程序执行中以一定间隔（默认值为 100msec）更新。 

 

1.11.1 窗口的结构 
 

变量类型 C语言
表达式

变量值

含程序计数器的源文件 工具栏

 

 

z 显示与程序计数器位置相应的源文件的文件内局部变量。 

通过逐步执行等操作，在相应源文件有更改的情况下，自动显示更改后的文件内局部变量。 

z 能将选择的 C 语言变量作为 C 监视点注册到 C 监视窗口。 

z 指针等的地址显示与显示基数无关被固定成 16 进制显示。 

z 能按各 C 语言变量更改显示基数（Hex→Dec→Bin）。 

 

1.11.2 窗口的选项 

在文件局部窗口被激活时，文件局部窗口提供以下菜单（称为文件局部窗口选项）： 
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菜单 菜单项目 功  能 
Font 更改字体 
Watch 

Cwatch 
CWatch Pointer 
Set... 
Cancel 

注册/删除 C 监视点 
作为 C 监视点进行注册 
作为 C 监视点进行注册（指针） 
设定 C 语言变量的存储器内容 
解除 C 语言变量的选择 

View 
Radix 
Layout 
Sort 
Display String 

更改显示内容 
更改显示基数 
转换变量类型名的显示/非显示 
按字母顺序排列 
转换文字显示/字符串显示 

Option 

RAM Monitor 
Enable 
RAM Monitor Area... 
Color... 
Sampling period... 
Clear 

RAM 监控显示 
转换 RAM 监控功能的有效/无效 
设定 RAM 监控区 
更改存取属性的显示颜色 
设定显示更新间隔 
清除存取属性 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 

 

1.12 全局窗口 

全局窗口是显示全局变量内容的窗口。能从窗口更改变量内容。 

如果指定的地址在 RAM 监控区内，就在目标程序执行中以一定间隔（默认值为 100msec）更新。 

 

1.12.1 窗口的结构 

 

变量类型 C语言
表达式

变量值

下载的模块文件 工具栏

 

z 能将选择的 C 语言变量作为 C 监视点注册到 C 监视窗口。 

z 指针等的地址显示与显示基数无关被固定成 16 进制显示。 

z 能按各 C 语言变量更改显示基数（Hex→Dec→Bin）。 
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1.12.2 窗口的选项 

 

菜单 菜单项目 功能 
Font 更改字体 
Watch 

Cwatch 
CWatch Pointer 
Set... 
Cancel 

注册/删除 C 监视点 
作为 C 监视点进行注册 
作为 C 监视点进行注册（指针） 
设定 C 语言变量的存储器内容 
解除 C 语言变量的选择 

View 
Radix 
Layout 
Sort 
Display String 

更改显示内容 
更改显示基数 
转换变量类型名的显示/非显示 
按字母顺序排列 
转换文字显示/字符串显示 

Option 

RAM Monitor 
Enable 
RAM Monitor Area... 
Color... 
Sampling period... 
Clear 

RAM 监控显示 
转换 RAM 监控功能的有效/无效 
设定 RAM 监控区 
更改存取属性的显示颜色 
设定显示更新间隔 
清除存取属性 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 

 

1.13 调用堆栈窗口 

调用堆栈窗口是显示目标程序的 C 语言函数调用状况的窗口。 

PD38（SIM）不支持。 

 

1.13.1 窗口的结构 

 

 

 

z 从当前程序计数器位置按顺序显示被调用的函数名、函数的调用位置（文件名、行号、地址）。 

z 第一行为当前 PC 位置的函数，最后一行为函数的调用源。 

z 通过双击函数名将该函数的调用位置（行）显示在程序窗口。 

 

1.13.2 窗口的选项 

在调用堆栈窗口被激活时，调用堆栈窗口提供以下菜单（称为调用堆栈窗口选项）： 
 

菜单 菜单项目 功  能 
Font 更改字体 Option 
Jump 
New window 

在程序窗口显示指定的函数 
在源窗口（新打开）显示指定的函数 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
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1.14 脚本窗口 

脚本窗口是用于执行脚本命令的窗口。 

在窗口下部的命令输入域输入脚本命令。命令的执行结果显示在执行结果显示区。 

主要操作按钮被配置在工具栏。 

 

1.14.1 窗口的结构 
工具栏

执行结果显示区

命令履历显示区

命令输入域

显示脚本文件名 显示记录文件名

 

z 能预先将要执行的脚本命令记述到文件（脚本文件），然后汇总执行。 

z 能将脚本命令的执行结果保存到预先指定的文件（记录文件）。 

z 脚本窗口能保存最新 1000 行的执行结果。即使忘记指定记录文件也能将脚本命令的执行结果保存到文

件（视图文件）。 

z 能将要执行的命令保存到预先指定的文件（作为脚本文件能再次使用）。 

 

1.14.2 窗口的选项 

在脚本窗口被激活时，脚本窗口提供以下菜单（称为脚本窗口选项）： 
 

菜单 菜单项目 功  能 
Font 更改字体 
Script 

Open... 
Run 
Step 
Close 

操作脚本文件 
打开脚本文件 
执行脚本文件 
逐步执行脚本文件 
关闭脚本文件 

View 
Save... 
Clear 

操作视图缓冲器 
视图缓冲器的文件保存 
清除视图缓冲器 

Log 
On... 
Off 

操作记录文件 
打开记录文件（输出开始） 
关闭记录文件（输出结束） 

Option 

Record 
On... 
Off 

记录命令 
命令的文件记录 
中止命令的文件记录 

 
也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
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1.15 保护窗口 

保护窗口是设定仿真器 PC4701U/M/HS 的保护暂停（存储器保护）功能的窗口。 

不能用于仿真器 PC4701L。 

保护暂停区为从 64K 字节边界开始的任意连续的 256K 字节。该起始地址称为保护基址。 

启动仿真器后的保护基址为 0h。 

 

1.15.1 窗口的结构 

 

地址范围显示区 保护暂停属性显示区

基址显示

工具栏

暂停模式显示

 

 

z 保护暂停功能在调试程序启动时无效。 

z 保护暂停的属性有以下 3 种： 

·Access Disable（不可读写，用红色显示） 

·Read Only（不可写，用黄色显示） 

·R/W Enable（可读写，用淡蓝色显示） 

z 保护暂停的设定有以下 2 种方法： 

·从目标程序的段信息指定 

·指定任意地址范围的存储器属性 

 

1.15.2 窗口的选项 

在保护窗口被激活时，保护窗口提供以下菜单（称为保护窗口选项）： 

 

菜单 菜单项目 功能 
Font 更改字体 Option 
Section 
Base Address...* 
Attribute... 
Mode 

设定保护暂停属性（段信息） 
设定保护基址 
设定保护暂停属性（任意地址范围） 
转换保护暂停功能的有效/无效 

*  PD38 没有此菜单项目。 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
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1.16 跟踪点设定窗口 

跟踪点设定窗口是设定跟踪点的窗口，不能用于仿真器 PC4701L。 

 

1.16.1 窗口的结构 

 

组合条件的设定

设定更改标志 当前事件列表

进程ID的设定

跟踪范围的设定

组合条件的选择 跟踪写条件的设定
 

z 能指定以下事件作为跟踪点。如果更改事件的内容就在标题栏显示“*”。 

 

产品名 
事件 

PD308 PD30 PD79 PD77 PD38 PD308SIM PD30SIM
取指令 ×* ○ ○ ×* ○ ○ ○ 
存储器存取 ○ ○ ○ ○ ○ ○ ○ 
位存取 ○ ○ ○ ○ ○ ○ ○ 
中断 × ○ × × ○ × × 
外部触发信号 ○ ○ ○ ○ ○ × × 

* 能用存储器存取代替（存取类型 Read）。 

 

z 能使用 6 件事件，可用以下方法组合： 

·有效事件中全部的事件都成立时暂停（AND 条件） 

·有效事件中全部的事件同时成立时暂停（同时 AND 条件） 

·有效事件中某个的事件成立时暂停（OR 条件） 

·在状态转移时转移到暂停状态时暂停（State Transition 条件） 
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1.16.2 事件的指定 

设定事件时，在跟踪点设定窗口的事件指定区双击要更改的事件行，打开以下对话框： 

 

设定的事件

指定事件种类

内容根据Event Type变换
 

能根据 Event Type 的指定设定以下事件： 

 

z 在选择 FETCH 时 

在执行取指令时暂停。（PD308、PD77 不支持。请用存储器存取的 Read 指定代替。） 
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z 在选择 DATA ACCESS 时 

能在存储器存取时暂停。 

 

 

z 在选择 BIT SYMBOL 时 

能在位存取时暂停。 

 

 

z 在选择 INTERRUPT 时 

能在中断发生/中断结束时暂停。 
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z 在选择 TRIGGER 时 

能在来自外部跟踪信号输入电缆的上升沿/下降沿暂停。 

 

 

1.16.3 组合条件的指定 

从组合条件指定区指定组合条件。 

 

z 在选择 AND、OR 时 

能在事件指定区指定使用的事件及其通过次数。要更改通过次数时，在选择了要更改的事件的状态下单

击该事件的通过次数值。 

 

 

z 在选择 AND（Same Time）时 

能在事件指定区指定要使用的事件。不能指定通过次数。 

 

z 在选择 STATE TRANSITION 时 

如果单击 Detail...按钮就打开以下窗口。能通过状态转移图或者顺序事件进行指定，也能指定各状态的

超时时间。 
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（PDxx 的情况） 

 

 

（PDxxSIM 的情况） 

 

 

1.16.4 进程 ID 的指定（PD79/PD77/PDxxSIM 不支持） 

能通过指定进程 ID 检测只在特定条件下成立的事件。例如，能在使用实时 OS 时检测只在特定任务中发生

的事件。 

 

 

1.16.5 跟踪范围的指定 

能对跟踪事件指定跟踪范围。在仿真调试程序PDxx的情况下，能记录32K周期数。在模拟调试程序PDxxSIM
的情况下，能记录在 Init 对话框的 Trace 选项卡所指定的周期数（以下记述为指定了 32K 周期的情况）。 
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z Break 
记录在目标程序停止之前的 32K 周期。 

z Before 
记录在跟踪条件成立之前的 32K 周期。 

z About 
记录在跟踪条件成立前后的 16K 周期。 

z After 
记录在跟踪条件成立后的 32K 周期。 

z Full 
记录从跟踪开始的 32K 周期。 

 

1.16.6 跟踪写条件的设定 

能指定对跟踪存储器写周期的条件。 

 

 

Total 写全部周期。 

Pick up 只写指定条件成立的周期。 

Exclude 只写指定条件不成立的周期。 

 

另外，支持以下 3 种写模式： 

 只限指定事件成立周期 

 从指定事件成立到指定事件不成立为止的周期 

 从开始事件成立到结束事件成立为止的周期 

 

1.16.7 命令按钮 

按钮名 内 容 
Reset 放弃窗口显示的内容，装入设定在仿真器中的内容 
Save… 将窗口设定的内容保存到文件 
Load… 装入保存在文件中的事件信息 
Set 将窗口设定的内容送给仿真器 
Close 关闭窗口 

 

1.16.8 窗口的选项 

跟踪点设定窗口提供在跟踪点设定窗口上单击鼠标右键的弹出式菜单。 

 

如果选定此菜单，就能在从跟踪点设定窗口打开的事件设定对话框输入地址时，使用输入履历（如果没选

定就显示程序中的标号一览表）。 
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1.17 H/W 断点设定窗口 

H/W 断点设定窗口是设定仿真器 PC4701U/M/PC4701HS 的硬件断点的窗口。不能用于仿真器 PC4701L。 

 

1.17.1 窗口的结构 

组合条件的设定

设定更改标志 当前事件列表

进程ID的设定组合条件的选择
 

启动调试程序时硬件暂停无效。要设定事件时，请选定 H/W 断点设定窗口的 Enable H/W Break 复选框。 

有关在 H/W 断点设定窗口的事件指定方法和事件组合条件的指定方法请参照“1.16 跟踪点设定窗口”。 

 

1.17.2 与跟踪点设定窗口的不同 

与跟踪点设定窗口相比，H/W 断点设定窗口有以下不同点： 

 

1.17.2.1 事件名 

在 H/W 断点设定窗口，事件名为 A1～A6；在跟踪点设定窗口，事件名为 B1～B6。 

 

1.17.2.2 事件的 Enable 复选框 

实时跟踪功能总是有效。因此，跟踪点设定窗口没有 Enable H/W Break 复选框。H/W 暂停功能只有在选定

了 Enable H/W Break 复选框时才有效。 

 

 

1.17.2.3 其它 

z H/W 断点设定窗口没有 Trace Area 区。 

z H/W 断点设定窗口没有 Write Condition 区。 
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1.18 跟踪窗口 

跟踪窗口是显示实时跟踪测量结果的窗口。跟踪窗口有以下 3 种显示模式： 
 

z 总线模式 

能参照各周期的总线信息，按执行路径顺序显示内容。 

z 反汇编模式 

能参照已执行的指令，按执行路径顺序显示内容。 

z 源模式 

能参照源程序的执行路径，操作工具栏的按钮参照路径。 

 

跟踪窗口在实时测量结束时显示测量结果。在实时测量还没结束时，跟踪窗口显示空白。 

 

作为默认值，记录目标程序停止前的 32K 周期数（在 PDxxSIM 的情况下，记录在 Init 对话框的 Trace 选项

卡指定的周期数）。如果要将跟踪测量范围更改到任意的事件位置，就必须在跟踪点设定窗口进行设定。 

有关跟踪点设定窗口的详细内容请参照“1.16 跟踪点设定窗口”。 

 

1.18.1 总线模式的结构 

跟踪窗口的总线模式结构如下（下图为用于 M16C/60、20 系列的调试程序 PD30 的表示例）： 

 

工具栏

标号显示区
周期显示区

总线信息显示区 执行时间显示区

测量范围 跟踪范围 当前周期
对应当前周期的地址

对应当前周期的执行时间

 

 

z 通过双击周期数显示区，能更改要显示的起始周期。 

z 通过双击总线信息显示区的 Address 列，能检索执行地址。 

z 在标号显示区和总线信息显示区之间，能用鼠标更改显示比例。 

z 总线信息显示区的各列根据所使用的调试程序而不同。 
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1.18.1.1 在 PD308 的总线信息显示 

从左端开始表示以下的内容： 

z Address 
表示地址总线的状态。 

z Data 
表示数据总线的状态。 

z BUS 
表示外部数据总线的宽度。宽度为 8 位时显示“8b”，宽度为 16 位时显示“16b”。 

z BIU 

表示 BIU（总线接口装置）和存储器、I/O 之间的状态。 
显示形式 状 态 

- 无变化 
WAIT 等待指令在执行中 
RBML 读（字节）ML ON 
F 连续取 
QC 不连续取 
RWML 读（字）ML ON 
INT 中断应答周期 
RB 读（字节） 
WB 写（字节） 
DRB 由 DMA 进行的读（字节） 
DWB 由 DMA 进行的写（字节） 
RW 读（字） 
WW 写（字） 
DRW 由 DMA 进行的读（字） 
DWW 由 DMA 进行的写（字） 

z R/W 

表示数据总线的状态。Read 状态时显示“R”，Write 状态时显示“W”，不存取时显示“-”。 
z RWT 

是表示总线周期有效位置的信号，有效时显示“0”。 
Address、Data、BIU 信号在本信息为“0”时有效。 

z CPU、OPC、OPR 
表示 CPU 和 BIU（总线接口装置）之间的状态。 
CPU 表示存取源，OPC 表示读取数据的操作码部分的大小，OPR 表示操作码以外部分的大小。 

显示形式 状 态 
CPU OPC OPR 操作码大小 操作码以外的大小 

- - - 指令队列无变化 
CPU 0 1 0 字节 1 字节 
CPU 0 2 0 字节 2 字节 
CPU 0 3 0 字节 3 字节 
CPU 1 0 1 字节 0 字节 
CPU 1 1 1 字节 1 字节 
CPU 1 2 1 字节 2 字节 
CPU 1 3 1 字节 3 字节 
CPU 2 0 2 字节 0 字节 
CPU 2 1 2 字节 1 字节 
CPU 2 2 2 字节 2 字节 
CPU 3 0 3 字节 0 字节 
CPU 3 1 3 字节 1 字节 
DMA - - DMA 状态 
DMAT - - DMA 状态（终端计数） 
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z B-T 
表示用于暂停事件的触发信号（外部跟踪信号输入电缆的 EXTIN7 管脚、紫色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z Q-T 

表示用于跟踪事件的触发信号（外部跟踪信号输入电缆的 EXTIN6 管脚、蓝色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z 76543210 

表示外部跟踪信号输入电缆的 EXTIN0～EXTIN7 的电平。 
High 电平时显示“1”，Low 电平时显示“0”。 
有关 EXTIN6～7，分别重复显示 B-T、Q-T。 

z h" m' s: ms.us 
表示目标程序开始执行后的经过时间。 

 

1.18.1.2 在 PD30 的总线信息显示 

从左端开始表示以下内容： 

z Address 
表示地址总线的状态。 

z Data 
表示数据总线的状态。 

z BUS 
表示外部数据总线的宽度。宽度为 8 位时显示“8b”，宽度为 16 位时显示“16b”。 

z BIU 

表示 BIU（总线接口装置）和存储器、I/O 之间的状态。 
显示形式 状 态 

- 无变化 
DMA 由DMA等CPU源以外进行的数据存取

INT INTACK 顺序开始 
IB 由 CPU 源进行的读指令码（字节） 
DB 由 CPU 源进行的存取数据（字节） 
IW 由 CPU 源进行的读指令码（字） 
DW 由 CPU 源进行的存取数据（字） 

z R/W 

表示数据总线的状态。Read 状态时显示“R”，Write 状态时显示“W”，不存取时显示“-”。 
z RWT 

是表示总线周期有效位置的信号，有效时显示“0”。 
Address、Data、BIU 信号在本信息为“0”时有效。 

z CPU 

表示 CPU 和 BIU 之间的状态。 
显示形式 状 态 

- 无变化 
CB 读操作码（字节） 
RB 读操作数（字节） 
QC 清除指令队列缓冲器 
CW 读操作码（字） 
RW 读操作数（字） 

z QN 

表示保存在指令队列缓冲器中的字节数。显示范围为 0～4。 
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z B-T 
表示用于暂停事件的触发信号（外部跟踪信号输入电缆的 EXTIN7 管脚、紫色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z Q-T 

表示用于跟踪事件的触发信号（外部跟踪信号输入电缆的 EXTIN6 管脚、蓝色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z 76543210 

表示外部跟踪信号输入电缆的 EXTIN0～EXTIN7 的电平。 
High 电平时显示“1”，Low 电平时显示“0”。 
有关 EXTIN6～7，分别重复显示 B-T、Q-T。 

z h" m' s: ms.us 
表示目标程序开始执行后的经过时间。 

 

1.18.1.3 在 PD79 的总线信息显示 

从左端开始表示以下内容： 

z Address 
表示地址总线的状态。 

z Data 
表示数据总线的状态。 

z BHE* 

表示 BHE（Byte High Enable）信号的状态（0 或 1）。此信号为“0”时表示正在存取奇数地址。 

z BUS16* 

表示总线宽度的状态。宽度为 8 位时显示“8b”，宽度为 16 位时显示“16b”，取指令时显示“---”。 

z DMAC 
表示由 DMAC 控制器进行的数据存取状态。 

z CH 

表示 DMA 运行通道（0～7）的状态。DMAC 为 0 时显示“-”。 
z BRN 

表示转移状态。“1”时为转移后的起始地址。 
z CYNC 

表示取指令的检测状态。“1”时为取指令，“0”时为存取数据。 
z INTACK* 

表示中断开始状态。“0”时为中断程序的起始地址。 
z R/W 

表示 MCU 数据状态。Read 状态时显示“R”，Write 状态时显示“W”，否则显示“-”。 
z 76543210 

表示外部跟踪信号输入电缆的 EXTIN0～EXTIN7 的电平。 
High 电平时显示“1”，Low 电平时显示“0”。 
有关 EXTIN6～7，分别重复显示 B-T、Q-T。 

z h" m' s: ms.us 
表示目标程序开始执行后的经过时间。 
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1.18.1.4 在 PD77 的总线信息显示 

从左端开始表示以下内容： 

z Address 
表示地址总线的状态。 

z Data 
表示数据总线的状态。 

z BUS 
表示外部数据总线的宽度。宽度为 8 位时显示“8b”，宽度为 16 位时显示“16b”。 

z BHE 
表示 BHE（Byte High Enable）信号的状态（0 或 1）。此信号为“0”时表示正在存取奇数地址。 

z R/W 

表示数据总线的状态。Read 状态时显示“R”，Write 状态时显示“W”，不存取时显示“-”。 
z DMA 

在 DMA 传送中，进行 1 总线传送时显示“1”，否则显示“0”。 
z VDA 

表示 VDA（Valid Data Address）信号的状态（0 或 1）。 
z VPA 

表示 VPA（Valid Program Address）信号的状态（0 或 1）。 
z QC 

表示 QCL（Queue Buffer Clear）的状态。清除队列时显示"Q"，否则显示"-"。 
z MX 

表示 M（m 标志）信号或者 X（x 标志）信号的状态（0 或 1）。 
z ST0 

表示 M37720 专用的外部信号 ST0 的状态（0 或 1）。 
z ST1 

表示 M37720 专用的外部信号 ST1 的状态（0 或 1）。 
z B-T 

表示用于暂停事件的触发信号（外部跟踪信号输入电缆的 EXTIN7 管脚、紫色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z Q-T 

表示用于跟踪事件的触发信号（外部跟踪信号输入电缆的 EXTIN6 管脚、蓝色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z 76543210 

表示外部跟踪信号输入电缆的 EXTIN0～EXTIN7 的电平。 
High 电平时显示“1”，Low 电平时显示“0”。 
有关 EXTIN6～7，分别重复显示 B-T、Q-T。 

z h" m' s: ms.us 
表示目标程序开始执行后的经过时间。 

 

1.18.1.5 在 PD38 的总线信息显示 

从左端开始表示以下内容： 

z Address 
表示地址总线的状态。 
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z Data 
表示数据总线的状态。 

z Sync 
是在取指令的操作码时输出的信号，取状态时显示“1”。 
Sync 值有被显示成“(1)”的情况，表示假 Sync，实际上此行的指令没被执行。 

z Read 
表示数据总线的状态。 
是决定数据总线方向的信号。Read 状态时显示“0”。 

z Write 
表示数据总线的状态。 

是决定数据总线方向的信号。Write 状态时显示“0”。 

z B-T 
表示用于暂停事件的触发信号（外部跟踪信号输入电缆的 EXTIN7 管脚、紫色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z Q-T 

表示用于跟踪事件的触发信号（外部跟踪信号输入电缆的 EXTIN6 管脚、蓝色）的电平。High 电平时

显示“1”，Low 电平时显示“0”。 
z 76543210 

表示外部跟踪信号输入电缆的 EXTIN0～EXTIN7 的电平。 
High 电平时显示“1”，Low 电平时显示“0”。 
有关 EXTIN6～7，分别重复显示 B-T、Q-T。 

z h" m' s: ms.us 
表示目标程序开始执行后的经过时间。 

 

1.18.1.6 在 PDxxSIM 的总线信息显示 

从左端开始表示以下内容： 

z Address 
表示地址总线的状态。 

z Data 
表示数据总线的状态。 

z Size 
表示存取数据的大小。 

z Type 
表示存取数据的种类。 

显示形式 状 态 
Code 表示助记符被取出的状态。 
Data 表示数据被存取 

z R/W 

表示数据大小的存取状态。 

显示形式 状 态 
R 读数据 
W 写数据 

z h" m' s: ms.us 
表示目标程序开始执行后的经过时间。 
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1.18.2 反汇编模式的结构 

跟踪窗口的反汇编模式的结构如下（下图是用于 M16C/60、20 系列的调试程序 PD30 的表示例。）： 
工具栏

测量范围 跟踪范围 当前周期

对应当前周期的地址

对应当前周期的执行时间

地址显示区 标号显示区 反汇编结果显示区
执行时间显示区目标码显示区周期显示区

 

z 通过双击周期数显示区，能更改要表示的起始周期。 

z 通过双击地址显示区，能检索执行地址。 

z 在目标码显示区和标号显示区之间、在标号显示区和反汇编结果显示区之间以及在反汇编结果显示区和

执行时间显示区之间，能用鼠标更改显示比例。 

 

1.18.3 源模式的结构 

跟踪窗口的源模式的结构如下（下图是用于 M16C/60、20 系列的调试程序 PD30 的表示例。）： 

工具栏

测量范围 跟踪范围 当前周期

对应当前周期的地址
对应当前周期的执行时间

当前源文件

行号显示区

地址显示区

参照周期位置显示区
源文件显示区
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z 行号显示区、地址显示区和目标码显示区能分别进行显示/非显示的转换。 

z 通过双击行号显示区，能更改要表示的源文件。 

z 通过双击地址显示区，能检索执行地址。 

z 通过先单击源文件显示区，再单击 Come 按钮，能检索单击位置的地址（Come 检索）。 

z 在参照周期位置显示区，将当前的周期位置显示为“>>”。“-”表示附带地址信息的行（能 Come 检

索的行）。 

 

1.18.4 窗口的选项 

在跟踪窗口被激活时，跟踪窗口提供以下菜单（称为跟踪窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
TAB… 设定源文件显示的制表符 
View 

Cycle... 
Address Search... 
Source... 

更改显示内容 
通过周期的指定进行更改 
通过地址的指定进行周期检索 
通过源文件的指定进行更改 

Mode 
Bus 
Disasm 
Source 

更改显示模式 
更改为总线模式 
更改为反汇编模式 
更改为源模式 

Layout 
Line Area 
Address Area 

布局设定 
转换行号显示区的显示/非显示 
转换地址显示区的显示/非显示 

Trace 
Forward 
Backward 
Step 
Come 

检索跟踪测量结果 
按正方向指定检索方向 
按反方向指定检索方向 
Step 检索（1 次检索） 
Come 检索（指定行的检索） 

Save... 将跟踪测量结果保存到文件 
Load... 从跟踪测量结果文件装入 
Trace Stop 強制停止跟踪测量 

Option 

Trace Restart 重新开始跟踪测量 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 

 

1.19 覆盖窗口 

覆盖窗口是为了参照已下载的目标程序各函数的覆盖测量结果的窗口。 

提供了能确认各函数的起始地址/结束地址和覆盖测量结果的覆盖窗口、能确认以源程序行为单位的执行/

未执行的覆盖源窗口。不能用于仿真器 PC4701L。 

 

z 能测量的覆盖为 C0 覆盖。 

z 覆盖测量区是从 64K 字节边界开始的任意 256K 字节。 

（PD38 和模拟调试程序 PDxxSIM 的全部空间为覆盖测量对象。） 
z 覆盖测量区的起始地址称为覆盖基址。 
z 默认值的覆盖基址是 0h。 
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1.19.1 覆盖窗口的结构 

覆盖窗口的结构如下： 

工具栏
覆盖基址

函数名显示区 函数范围显示区 覆盖率显示区  

z 通过双击函数的任意行，在覆盖源窗口显示相应的函数。 

z 在覆盖测量中，覆盖显示区显示“-%”。 

z 在函数名显示区和函数范围显示区之间，能用鼠标更改显示比例。 

 

由于 PD38 和模拟调试程序 PDxxSIM 的全存储器空间为覆盖测量对象，所以没有 Base 按钮。 

 

1.19.2 覆盖源窗口的结构 

覆盖源窗口的结构如下： 

 

行号显示区
地址显示区 程序显示区

 

z 已执行的行的背景色用淡蓝色显示，没执行的行的背景色用灰色显示，没有行号信息的行（注解行、空

白行等）的背景色用白色显示。 

z 行号显示区和地址显示区能分别进行显示/非显示的转换。 
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1.19.3 窗口的选项 

在覆盖窗口被激活时，覆盖窗口提供以下菜单（称为覆盖窗口选项）： 
 

菜单 菜单项目 功  能 
Font 更改字体 
Refresh 更新显示覆盖测量结果 
Clear 覆盖测量结果的初始化 
Base* 更改覆盖基址 
File 

Save... 
Load... 

覆盖测量结果的文件输入/输出 
保存覆盖测量结果 
装入覆盖测量结果 

Option 

Layout 
Address Area 

布局设定 
转换地址显示区的显示/非显示 

*  PD38 和全部模拟调试程序 PDxxSIM 没有此菜单项目。 

 

在覆盖源窗口被激活时，覆盖源窗口提供以下菜单（称为覆盖源窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
TAB… 设定源文件表示的制表符 

Option 

Layout 
Line Area 
Address Area 

布局设定 
转换行号显示区的显示/非显示 
转换地址显示区的显示/非显示 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 

 

1.20 区间时间测量窗口 

区间时间测量窗口是显示任意区间的最小执行时间、最大执行时间和平均执行时间以及测量次数的窗口。

最多能同时测量 4 点区间时间。 

能对测量条件的事件进行与在 H/W 断点设定窗口和跟踪点设定窗口中事件设定相同的指定。 

有关事件指定的详细内容请参照“1.16 跟踪点设定窗口” 

区间时间测量窗口不能用于仿真器 PC4701L。 
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1.20.1 窗口的结构 

事件指定区 测量结果清除按钮

测量结果显示区

区间设定显示区  

 

◆注意事项◆ 

z 跟踪点设定窗口和区间时间测量窗口使用仿真器的相同资源。因此，如果在区间时间测量窗口更改事件，

在跟踪点设定窗口设定的内容也将被更改。 

z 区间时间测量的计数源不能指定仿真器内的时钟而必须指定 MCU 周期（目标电路板的工作时钟）。如

果指定为仿真器内的时钟，就会出现错误的测量结果。 

 

1.20.2 区间时间测量条件 

区间时间的测量条件能按各测量区间进行如下的指定： 
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 测量从事件成立到下个事件成立为止的时间。 

 测量从事件成立到不成立为止的时间。 

 测量从区间开始事件成立到区间结束事件成立为止的时间。 

 

测量函数的执行时间。自动将函数的起始地址注册给开始事件、将

函数的结束地址注册给结束事件。 
测量结果也包含指定函数内调用的其它函数的执行时间。 

 

测量函数的执行时间。将从函数开始到函数结束的地址自动注册给

事件。 
如果用此模式测量，就在指定函数调用其它函数时暂时结束测量，

然后在返回时重新开始测量。因此，在指定函数调用其它函数时，

不能使用此设定方法测量整个指定函数的执行时间。 

 

1.20.3 命令按钮 

按钮名 内  容 
Reset 放弃窗口显示的内容，装入设定在仿真器的内容 
Save… 将窗口设定的内容保存到文件 
Load… 装入保存在文件中的事件信息 
Set 将窗口设定的内容送给仿真器 
Close 关闭窗口 

 

1.21 MR 窗口 

MR 窗口是显示实时 OS 状态的窗口（PD38（SIM）不支持）。 

只能用于下载使用实时 OS 的程序。 

如果下载的程序不使用 MR，即使打开 MR 窗口，MR 窗口也不显示任何信息。 

 

1.21.1 窗口的结构 

能打开显示模式种类个数的 MR 窗口（现在最大为 9 个）。 

 

通过单击各按钮，转换 MR 窗口的显示模式和显示内容。 

 
通过双击各任务行，能显示该任务的上下文内容。 

通过拖动操作，能更改各模式的各显示区的显示宽度。 

 

如果下载的程序没有使用 MR，就不能选择所有选择显示模式的菜单。 
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MR 窗口支持以下的显示： 

z 显示任务的状态 

z 显示就绪队列的状态 

z 显示超时队列的状态 

z 显示事件标志的状态 

z 显示信标的状态 
z 显示邮箱的状态 
z 显示周期启动处理程序的状态 
z 显示报警处理程序的状态 

z 显示存储库的状态 
 
对于 MR30，在下载由 MR30 V.1.00 建立的目标程序时，不能使用 MPL 模式（不能选择更改为 MPL 模式

的菜单）。 
 

1.21.2 窗口的选项 

在 MR 窗口被激活时，MR 窗口提供以下菜单（称为 MR 窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
Mode 

Task 
Ready Queue 
Timeout Queue 
Event Flag 
Semaphore 
Mailbox 
Cyclic Handler 
Alarm Handler  
Memory Pool 

转换显示模式 
显示任务的状态 
显示就绪队列的状态 
显示超时队列的状态 
显示事件标志的状态 
显示信标的状态 
显示邮箱的状态 
显示周期启动处理程序的状态 
显示报警处理程序的状态 
显示存储库的状态 

MR 
Context... 

 
显示上下文 

Option 

Layout 
Status Bar 

布局设定 
转换状态栏的显示/非显示 

 

1.22 MR 跟踪窗口 

MR跟踪窗口是测量使用实时OS的程序的任务执行履历等并以图形显示其测量结果的窗口（仅PD308/PD30
支持此功能）。 

除任务执行履历以外，也同时测量和显示中断处理、任务状态转移、系统调用发行的各履历。 

只能用于下载使用瑞萨实时 OS（MRxx）的目标程序。 

 

对于 MR30，以 MR30 V.2.00 以上的版本为对象。在下载由 MR30 V.1.00 建立的目标程序时，MR 跟踪窗口

不作用，也不显示任何信息。 
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1.22.1 窗口的结构 

 

 

各项目的内容如下： 

项目 内容 
VEC *1 显示软件中断序号。 
table 显示中断向量表地址。 
ID 显示任务的 ID 序号。 
（name） 显示中断程序名、任务名、空闲处理（显示“idle”）、不明（显示“unknown”）。 

 
通过将鼠标光标移动到窗口显示的各信息，打开如下的弹出式窗口并显示详细信息： 

 

中断处理、任务执行履历的详细显示信息 

 

 

系统调用发行履历的详细显示信息 

 

 

任务状态转移履历的详细显示信息 

 

 

在状态栏显示以下信息： 

z 开始标志位置的时刻值 

z 结束标志位置的时刻值 

z 开始标志和结束标志间的时间宽度 

z 指示符位置的时刻值 

z 显示倍率 

z 网格线间隔时间宽度 
z 测量（跟踪）范围 
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以开始标志为基点显示网格线。 

刻度以开始标志所在位置的时刻为 0、左侧（在时间上为前）为负、右侧（在时间上为后）为正。 

通过网格线能粗略地把握中断发生周期和处理时间等。 

显示的网格线的间隔时间宽度表示在状态栏的“Grid”区。 

 

MR 跟踪窗口的全部时刻值表示以程序的执行开始时刻为 0 的执行经过时间。 

对此，MR 跟踪窗口的网格线（刻度）上部的数字是以开始标志为 0 的相对值（在 Value 对话框指定网格间

隔），与时刻值无关（为了使窗口易看）。 

 

◆补充事项◆ 

VEC 列*1的软件中断序号根据产品而不同。 

 

PD308 
为了系统调用的发行，MR308 预约了 INT 指令的中断序号（48～63），中断序号 48～63 表示的中断程序

名如下： 

 

中断序号 中断程序名 
63 （_SYSCALL0） 
62 （_SYSCALL1） 
61 （_sys_ret_int） 
60 （_sys_dis_dsp） 
59 （_sys_loc_cpu） 
58 （_sys_ext_tsk） 
57 （_SYSCALL2） 
56 （_SYSCALL3） 
55 （_SYSCALL4） 

54～48 未使用 

有关什么样的系统调用分配哪个中断序号，请参照 MR308 的参考手册。 

 

PD30 
为了系统调用的发行，MR30 预约了 INT 指令的中断序号（32～47），中断序号 32～47 表示的中断程序名

如下： 
中断序号 中断程序名 

32 （_SYSCALL0） 
33 （_SYSCALL1） 
34 （_sys_ret_int） 
35 （_sys_dis_dsp） 
36 （_sys_loc_cpu） 
37 （_sys_ext_tsk） 
38 （_SYSCALL2） 
39 （_SYSCALL3） 
40 （_SYSCALL4） 

41～47 未使用 

有关什么样的系统调用分配哪个中断序号，请参照 MR30 的参考手册。 
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1.22.2 窗口的选项 

在 MR 跟踪窗口被激活时，MR 跟踪窗口提供以下菜单（称为 MR 跟踪窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
Mark S 
Mark E 
Indicator 

移动到开始标志的显示画面内 
移动到结束标志的显示画面内 
移动到指示符的显示画面内 

Adjust 
Expand 
Reduce 

以横向最大限地显示开始/结束标志的范围 
扩大显示倍率 
缩小显示倍率 

After 
Break 

将测量范围条件设定为 After 
将测量范围条件设定为 Break 

Trace Stop 
Trace Restart 

強制停止测量 
重新开始测量 

Option 

Value... 
Color... 
Search... 
Init Order 

设定各种值 
设定各种显示颜色 
检索系统调用发行履历 
显示顺序的初始化 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
 

1.23 MR 解析窗口 

MR 解析窗口是显示测量数据（由 MR 跟踪窗口的开始标志和结束标志指定的范围）的统计结果的窗口（仅

PD308/PD30 支持此功能）。 

MR 解析窗口支持以下 3 个显示模式： 

z 各中断处理和各任务的 CPU 占有状况 

z 各任务的就绪状态时间 

z 显示系统调用发行履历的一览表（能根据特定条件的指定抽出显示） 

 

MR 解析窗口与 MR 跟踪窗口一起作用。 

只能用于下载使用瑞萨实时 OS（MRxx）的目标程序。 

 

1.23.1 CPU 占有状况显示模式的结构 

CPU 占有状况显示模式是用于显示各中断处理和各任务的 CPU 占有时间和比率的模式。 

显示在 MR 跟踪窗口的开始标志和结束标志指定的范围内的统计结果。 
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通过单击各行的最大执行时间或最小执行时间显示区，能检索与单击的行对应的中断处理或任务的最大执

行时间或最小执行时间的处理履历。 

将 MR 跟踪窗口的指示符移动到对象位置，指示检索结果。 

 

1.23.2 各任务就绪状态时间显示模式的结构 

各任务就绪状态时间显示模式是用于显示各任务从执行可能状态转移到执行状态的时间统计结果的模式。 

显示在 MR 跟踪窗口的开始标志和结束标志指定的范围内的统计结果。 

 

 

 

通过单击各行的最大就绪时间或最小就绪时间显示区，能检索与单击的行对应的任务的最大就绪时间或最

小就绪时间的处理履历。 

将 MR 跟踪窗口的指示符移动到对象位置，指示检索结果。 
 

1.23.3 系统调用发行履历一览表显示模式的结构 
系统调用发行履历一览表显示模式是用于显示已发行的系统调用列表的模式。 
以列表形式显示在 MR 跟踪窗口的开始标志和结束标志指定的范围内的系统调用发行履历一览表。 
但是，序号表示在可测量的范围内对系统调用从头开始计算的数值。 
 

 

 
通过单击各行，能检索与单击的行对应的系统调用发行履历。 
将 MR 跟踪窗口的指示符移动到对象位置，指示检索结果。 
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1.23.4 窗口的选项 
在 MR 解析窗口被激活时，MR 解析窗口提供以下菜单（称为 MR 解析窗口选项）： 
 

菜单 菜单项目 功能 
Font 更改字体 
Run Time 更改为 CPU 占有状况显示模式 
Rdy->Run 更改为各任务就绪状态时间显示模式 
System Call 更改为系统调用发行履历一览表显示模式 

Option 

Pick Up System Call… 更改为由特定条件的指定抽出显示系统调用发行履历一览表的模式 

 
也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
 

1.24 MR 任务暂停窗口 
MR 任务暂停窗口是用于实现实时 OS（MRxx）的任务暂停功能的窗口（仅 PD308/PD30 支持此功能）。 
能从此窗口指定特定任务的停止（Pause）和停止解除等。 
此窗口只能用于下载含 MRxx 任务暂停功能的系统和系统时钟定时器的程序。 

 

对于 MR30，以 MR30 V.3.00 以上的版本为对象，由以前的 MR30 版本建立的目标程序不能使用。 
 

1.24.1 窗口的结构 

 

 

任务暂停显示区显示在建立目标程序时由配置文件定义的全部任务的有关信息（ID 序号、名称、Pause 状

态时的上下文 PC 值）。在此显示区选择各任务暂停处理的对象任务。 

任务源显示区显示指定的程序内容。在进行任务暂停 Come 处理时，在此显示区内用光标指定停止位置。 

 

有关任务暂停功能 

任务暂停功能是指在执行目标系统时只停止或解除停止特定任务的功能。 

如果使用任务暂停功能，就能在执行除特定任务以外的其它所有任务和中断的状态下只停止特定任务。 



第 1 章  窗口一览 

Rev.1.00 2005.02.18 page 105 of 132 
RCJ10J0010-0100 

 

另外，由于能进行 Come 执行等的调试工作，所以不会对由任务或中断等控制的外围器件产生影响，能提

高调试效率。 

在本节中所使用的术语定义如下： 
 

z Pause 状态 

指使用 MR 任务暂停窗口，在目标执行中停止特定任务时的任务状态。 

 

z 任务暂停 Pause 处理 

指使用 MR 任务暂停窗口，在目标执行中将特定任务设定为 Pause 状态的处理。 

 

z 任务暂停 Go 处理 

指使用 MR 任务暂停窗口，在目标执行中解除特定任务的 Pause 状态的处理。 

 

z 任务暂停 Come 处理 

指使用 MR 任务暂停窗口，在目标执行中，在指定位置将特定任务设定为 Pause 状态的处理。 

 

1.24.2 窗口的选项 

在 MR 任务暂停窗口被激活时，MR 任务暂停窗口提供以下菜单（称为 MR 任务暂停窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 
Pause 

Go 
Come 
Pause 

任务暂停功能 
对象任务的任务暂停 Go 处理 
对象任务的任务暂停 Come 处理 
对象任务的任务暂停 Pause 处理 

TAB... 设定源文件显示的制表符 
Color... 设定源文件显示的显示颜色 
View 

Source... 
Address... 
Program Counter 

更改显示内容 
更改源文件/函数级的显示 
更改地址/行号级的显示 
更改对程序计数器位置*的显示 

Mode 
Source Mode 
Mix Mode 
Disasm Mode 

更改显示模式 
更改为源显示模式 
更改为 MIX 显示模式 
更改为反汇编模式 

Option 

Layout 
Line Area 
Address Area 
Code Area 

布局设定 
转换行号显示区的显示/非显示 
转换地址显示区的显示/非显示 
转换目标码显示区的显示/非显示 

 

* 如果通过指定 PC 位置更改程序显示位置，就在 MR 任务暂停窗口进行如下运行： 

 

z 在任务暂停显示区所选择的对象任务的状态为 Pause 时 

→更改为从对象任务的上下文 PC 位置进行显示。 

z 在任务暂停显示区所选择的对象任务的状态不为 Pause 时 

→不更改显示位置。 
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z 在任务暂停显示区对象任务没被选择时 

→更改为从当前程序计数器位置进行显示（和源窗口的运行相同）。 

 

1.25 Task 跟踪窗口 

Task 跟踪窗口是测量使用实时 OS 程序的任务执行履历并以图形显示其测量结果的窗口。 

也能用于下载使用瑞萨实时 OS（MRxx）以外的 OS 的目标程序。 

 

1.25.1 窗口的结构 

 

 

各项目的内容如下： 

项目 内  容 
ID 显示任务的 ID 序号。 
（name） 显示中断程序名、任务名、空闲处理（显示“idle”）、不明（显示“unknown”）。 

 

通过将鼠标光标移动到窗口显示的各信息，打开如下的弹出式窗口并显示详细信息： 
 

中断处理、任务执行履历的详细显示信息 

 
 
在状态栏显示以下信息： 

z 开始标志位置的时刻值 

z 结束标志位置的时刻值 

z 开始标志和结束标志间的时间宽度 

z 指示符位置的时刻值 

z 显示倍率 

z 网格线间隔时间宽度 
z 测量（跟踪）范围 
 

以开始标志为基点显示网格线。 

刻度以开始标志所在位置的时刻为 0、左侧（在时间上为前）为负、右侧（在时间上为后）为正。 

通过网格线能粗略地把握中断发生周期和处理时间等。 

显示的网格线的间隔时间宽度表示在状态栏的“Grid”区。 
 

Task 跟踪窗口的全部时刻值表示以程序的执行开始时刻为 0 的执行经过时间。 
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对此，Task 跟踪窗口的网格线（刻度）上部的数字是以开始标志为 0 的相对值（在 Value 对话框指定网格

间隔），与时刻值无关（为了使窗口易看）。 

 

1.25.2 窗口的选项 

在 Task 跟踪窗口被激活时，Task 跟踪窗口提供以下菜单（称为 Task 跟踪窗口选项）： 
 

菜单 菜单项目 功  能 
Font 更改字体 
Mark S 
Mark E 
Indicator 

移动到开始标志的显示画面内 
移动到结束标志的显示画面内 
移动到指示符的显示画面内 

Adjust 
Expand 
Reduce 

以横向最大限地显示开始/结束标志的范围 
扩大显示倍率 
缩小显示倍率 

After 
Break 

将测量范围条件设定为 After 
将测量范围条件设定为 Break 

Trace Stop 
Trace Restart 

強制停止测量 
重新开始测量 

Option 

Value... 
Color... 
RTOS... 

设定各种值 
设定各种显示颜色 
对象实时 OS 信息的设定 

 
也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
 

1.26 Task 解析窗口 

Task 解析窗口是显示测量数据（由 Task 跟踪窗口的开始标志和结束标志指定的范围）的统计结果的窗口。 

Task 解析窗口显示 CPU 占有状况。 

Task 解析窗口与 Task 跟踪窗口一起作用。 

也能用于下载使用瑞萨实时 OS（MRxx）以外的 OS 的目标程序。 

 

1.26.1 窗口的结构 

CPU 占有状况显示模式是用于显示各任务的 CPU 占有时间和比率的模式。 

显示在 Task 跟踪窗口的开始标志和结束标志指定的范围内的统计结果。 
 

 

 

通过单击各行的最大执行时间或最小执行时间显示区，能检索与单击的行对应的任务的最大执行时间或最

小执行时间的处理履历。 

将 Task 跟踪窗口的指示符转移到对象位置，指示检索结果。 
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1.26.2 窗口的选项 

在 Task 解析窗口被激活时，Task 解析窗口提供以下菜单（称为 Task 解析窗口选项）： 

 

菜单 菜单项目 功  能 
Font 更改字体 Option 
Run Time 更改为 CPU 占有状况显示模式 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 

 

1.27 GUI 输入窗口 

GUI 输入窗口是在窗口上建立用户目标系统的键输入面板（按钮）并通过单击建立的按钮进行端口输入的

窗口。 

 

1.27.1 窗口的结构 
 

 

 

输入面板能配置以下部件： 
z 按钮 

能在按下按钮时进行虚拟端口输入和虚拟中断（虚拟中断只限于 PDxxSIM）。 
z 文本 

显示文本字符串。 

 

能给建立的按钮起标号（按钮名）。 

也能将建立的输入面板保存到文件并能重新读取。 
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1.27.2 窗口的选项 

在 GUI 输入窗口被激活时，GUI 输入窗口提供以下菜单（称为 GUI 输入窗口选项）： 
 

菜单 菜单项目 功  能 
Set 编辑/移动按钮 
Del 
Copy 
Paste 

删除按钮 
复制按钮 
粘贴按钮 

Make Button 
 
Display Grid Line 

建立按钮 
建立文本 
转换网格线的显示/非显示 

Option 

Load... 
Save... 

读 GUI 输入文件 
保存 GUI 输入文件 

 

也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
 

1.28 GUI 输出窗口 

GUI 输出窗口是能通过窗口实现用户目标系统的输出面板的窗口。 

 

1.28.1 窗口的结构 
 

 
 
输出面板能配置以下部件： 

z 标号（字符串） 
在给指定地址（位）写任意值时，显示/消去用户指定的字符串。 

z LED 
在给指定地址（位）写任意值时，更改任意区域的显示颜色（代替 LED 点灯）。 

z 文本 
显示文本字符串。 

 
能给建立的按钮起标号（按钮名）。 

也能将建立的输入面板保存到文件并能重新读取。 

给建立的部件最多能设定 200 个地址。 

如果给各部件设定的地址全部不同，能配置的部件数就为 200 个。 
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1.28.2 窗口的选项 

在 GUI 输出窗口被激活时，GUI 输出窗口提供以下菜单（称为 GUI 输出窗口选项）： 
 

菜单 菜单项目 功能 
Set 编辑/移动按钮 
Del 
Copy 
Paste 

删除按钮 
复制按钮 
粘贴按钮 

Make Label 
Make LED 
Make Text 
Display Grid Line 

建立标号 
建立 LED 
建立文本 
转换网格线的显示/非显示 

Load... 
Save... 

读 GUI 输出文件 
保存 GUI 输出文件 

Option 

RAM Monitor 
RAM Monitor Area… 
Sampling period... 

RAM 监控显示 
设定 RAM 监控区 
设定显示更新间隔 

 
也能通过在窗口内单击鼠标右键的快捷方式菜单来选择这些菜单。 
 

1.29 S/W 断点设定对话框 

S/W 断点设定对话框是用于设定软件断点的对话框。 

软件暂停在执行指定地址的指令之前发生暂停。 

断点注册域

对断点的操作

断点显示区

 

能设定 64 个软件断点。 

z 能用“地址”级或“文件名+行号”级指定断点。 

z 如果设定多个断点，就在遇到任意 1 个断点时停止目标程序（OR 条件）。 

z 能对各断点进行删除和无效/有效的转换。 

z 能将断点信息保存到文件，也能读取保存的断点信息。 
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1.30 H/W 断点设定对话框（PC4701L） 

H/W 断点设定对话框（PC4701L）是用于设定硬件断点的对话框。 

不能用于仿真器 PC4701U/M/HS。 

能设定 1 个地址断点。 

也能指定通过次数。 

 

 

z 地址断点的存取条件能指定取指令（Fetch）和存储器存取（Write、Read、R/W）（PD308/PD79/PD77
不支持取指令）。 

z 如果从地址断点读取的数据或者给地址断点写的数据是特定值，也能指定暂停。而且，也能对该特定值

指定有效位/无效位。 

z 能将断点信息保存到文件，也能读取保存的断点信息。 

 

1.31 芯片断点设定对话框 

芯片断点设定对话框是用于设定芯片暂停的对话框（只有 PD79 支持）。 

芯片暂停是与仿真存储区、处理器模式的设定以及所使用的仿真器无关而总能使用的功能。 

 

 

 



第 1 章  窗口一览 

Rev.1.00 2005.02.18 page 112 of 132 
RCJ10J0010-0100 

 

z 能指定取指令（Fetch）和存储器存取（Write、Read、R/W）。 

z 如果从地址断点读取的数据或者给地址断点写的数据是特定值，也能指定暂停。而且，也能对该特定值

指定有效位/无效位。 

z 能指定的地址为 2 个，这 2 个地址能进行如下的组合： 

·只存取第 1 个地址 

·只存取第 2 个地址 

·第 1 个地址或者第 2 个地址的 OR 条件 

·在第 1 个地址～第 2 个地址内存取 

·在第 1 个地址～第 2 个地址以外存取 

 

1.31.1 芯片断点参照/删除对话框 

芯片断点参照/删除对话框是用于参照/删除芯片断点设定的对话框（只有 PD79 支持）。 
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第2章 脚本命令一览表 

本调试程序有以下的脚本命令： 
命令名的括号内的文字（U、M、H、L）指对应的仿真器，没有括号的脚本命令能用于全部 PC4701 仿真器。 
U ··· PC4701U 
M ··· PC4701M 
H ··· PC4701HS 
L ··· PC4701L 
 
另外，运行时能执行阴影显示的脚本命令。 
有的产品不支持后面带“*”的命令。 
各命令的详细说明请参照 PD 的帮助。显示帮助时，请选择 PD 窗口的菜单[Help]→[Contents]。 
 

2.1 脚本命令一览表（按功能顺序） 
 

2.1.1 执行关联的命令 
命令名 缩写名 内  容 

Go G 执行目标程序 
GoFree GF 目标程序的自由运行 
GoProgramBreak* GPB 带暂停执行目标程序（指定地址） 
GoBreakAt* GBA 带暂停执行目标程序（指定行号） 
Stop - 目标程序的停止 
Status - 显示目标程序的执行状态 
Step S 源级的逐步执行 
StepInstruction SI 机器语言级的逐步执行 
OverStep O 源级的跨步执行 
OverStepInstruaction OI 机器语言级的跨步执行 
Return RET 源级的返回执行 
ReturnInstruction RETI 机器语言级的返回执行 
Reset - 目标程序的复位 
Time - 设定执行时间的显示 

 

2.1.2 下载关联的命令 
命令名 缩写名 内  容 

Load L 目标程序的汇总下载 
LoadHex LH 下载机器语言信息（intel HEX 格式文件） 
LoadMot* LM 下载机器语言信息（Motorola S 格式文件） 
LoadSymbol LS 下载源程序行/汇编程序符号信息 
LoadIeee* LI 下载 C 语言变量/函数信息 
Reload - 重新下载目标程序 
UploadHex UH 将机器语言信息加载到 intel HEX 格式文件 
UploadMot* UM 将机器语言信息加载到 Motorola S 格式文件 
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2.1.3 寄存器操作关联的命令 
命令名 缩写名 内  容 

Register R 参照指定寄存器的值 

 

2.1.4 存储器操作关联的命令 
命令名 缩写名 内  容 

DumpByte DB 以 1 字节单位显示存储器内容 
DumpWord* DW 以 2 字节单位显示存储器内容 
DumpLword* DL 以 4 字节单位显示存储器内容 
DumpDword* DD 以 4 字节单位显示存储器内容 
SetMemoryByte MB 以 1 字节单位更改存储器内容 
SetMemoryWord* MW 以 2 字节单位更改存储器内容 
SetMemoryLword* ML 以 4 字节单位更改存储器内容 
SetMemoryDword* MD 以 4 字节单位更改存储器内容 
FillByte FB 以 1 字节单位填充存储器内容 
FillWord* FW 以 2 字节单位填充存储器内容 
FillLword* FL 以 4 字节单位填充存储器内容 
FillDword* FD 以 4 字节单位填充存储器内容 
Move - 以 1 字节单位传送存储器内容 
MoveWord* MOVEW 以 2 字节单位传送存储器内容 

 

2.1.5 汇编/反汇编关联的命令 
命令名 缩写名 内  容 

Assemble A 从指定的地址以 1 行单位进行汇编 
DisAssemble DA 显示指定范围的反汇编结果 
Module MOD 显示全部模块（目标名） 
Scope - 显示当前作用域/更改作用域 
Section SEC 显示段信息 
Bit* - 参照/设定位符号 
Symbol SYM 显示符号 
Express EXP 显示指定的汇编程序表达式的值 

 

2.1.6 软件断点设定关联的命令 
命令名 缩写名 内  容 

SoftwareBreak SB 显示/设定软件断点 
SoftwareBreakClear SBC 删除软件断点 
SoftwareBreakClearAll SBCA 删除全部软件断点 
SoftwareBreakDisable SBD 软件断点的无效 
SoftwareBreakDisableAll SBDA 全部软件断点的无效 
SoftwareBreakEnable SBE 软件断点的有效 
SoftwareBreakEnableAll SBEA 全部软件断点的有效 
BreakAt - 指定行号级的软件断点 
BreakIn - 在函数的开头指定软件断点 
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2.1.7 硬件断点设定关联的命令 
命令名 缩写名 内  容 

HardwareBreak（U/M/H） HB 指定硬件断点 
HardwareBreak（L） HB 指定硬件断点 
Protect（U/M/H） PT 指定存取保护 
BreakMode（U/M/H） BM 参照/设定暂停模式 
BreakMode（L） BM 参照/设定暂停模式 

 

2.1.8 实时跟踪关联的命令 
命令名 缩写名 内  容 

TracePoint（U/M/H） TP 指定跟踪点 
TraceData（U/M/H） TD 实时跟踪结果的总线信号显示 
TraceList（U/M/H） TL 实时跟踪结果的反汇编显示 

 

2.1.9 覆盖测量关联的命令 
命令名 缩写名 内  容 

Coverage（U/M/H） CV 显示覆盖测量结果 

 

2.1.10 脚本/记录文件关联的命令 
命令名 缩写名 内  容 

Script - 打开脚本文件 
Exit - 关闭脚本文件 
Wait（U/M/H） - 等待命令输入 
Wait（L） - 等待命令输入 
Pause - 显示指定信息，等待按钮输入 
Sleep - 指定秒数的命令输入等待 
Logon - 打开记录文件 
Logoff - 关闭记录文件 

 

2.1.11 程序窗口关联的命令 
命令名 缩写名 内  容 

Func - 参照函数名/显示函数内容 
Up* - 显示调用源函数 
Down* - 显示调用目标函数 
Where* - 显示函数调用状况 
Path - 指定源文件的路径 
File - 显示指定的源文件 

 

2.1.12 映像关联的命令 
命令名 缩写名 内  容 

Map - 参照/设定映像 
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2.1.13 供给时钟关联的命令 
命令名 缩写名 内  容 

Clock CLK 设定/参照 MCU 的供给时钟 

 

2.1.14 C 语言关联的命令 
命令名 缩写名 内  容 

Print - 参照 C 语言变量表达式 
Set - 指定 C 语言变量表达式的数据 

 

2.1.15 实时 OS 关联的命令 
命令名 缩写名 内  容 

MR* - 显示瑞萨实时 OS（MRxx）的状态 

 

2.1.16 自定义命令/窗口关联的命令 
命令名 缩写名 内  容 

Macro - 注册/参照自定义程序 
DelMacro - 删除指定的自定义程序 
DelMacroAll - 删除全部自定义程序 
MacroPath MPATH 设定/参照自定义程序的路径 

 

2.1.17 实用程序关联的命令 
命令名 缩写名 内  容 

Radix - 设定/参照常数的既定值 
Alias - 定义命令的别名/参照定义状况 
UnAlias - 删除命令的别名定义 
UnAliasAll - 删除全部命令的别名定义 
Help H 显示脚本命令的帮助 
Version VER 显示调试程序的版本 
Date - 显示现在的日期和时间 
Echo - 显示信息 
Quit - 结束调试程序 
CD - 设定/参照当前目录 
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2.2 脚本命令一览表（按字母顺序） 
命令名 缩写名 内容 

Alias - 定义命令的別名/参照定义状况 
Assemble A 从指定的地址以 1 行单位进行汇编 
Bit* - 参照/设定位符号 
BreakAt - 指定行号级的软件断点 
BreakIn - 在函数的开头指定软件断点 
BreakMode（U/M/H） BM 参照/设定暂停模式 
BreakMode（L） BM 参照/设定暂停模式 
CD - 设定/参照当前目录 
Clock CLK 设定/参照 MCU 的供给时钟 
Coverage（U/M/H） CV 显示覆盖测量结果 
Date - 显示现在的日期和时间 
DelMacro - 删除指定的自定义程序 
DelMacroAll - 删除全部自定义程序 
DisAssemble DA 显示指定范围的反汇编结果 
Down* - 显示调用目标函数 
DumpByte DB 以 1 字节单位显示存储器内容 
DumpDword* DD 以 4 字节单位显示存储器内容 
DumpLword* DL 以 4 字节单位显示存储器内容 
DumpWord* DW 以 2 个字节单位显示存储器内容 
Echo - 显示信息 
Exit - 关闭脚本文件 
Express EXP 显示指定的汇编程序表达式的值 
File - 显示指定的源文件 
FillByte FB 以 1 字节单位填充存储器内容 
FillDword* FD 以 4 字节单位填充存储器内容 
FillLword* FL 以 4 字节单位填充存储器内容 
FillWord* FW 以 2 字节单位填充存储器内容 
Func - 参照函数名/显示函数内容 
Go G 执行目标程序 
GoBreakAt* GBA 带暂停执行目标程序（指定行号） 
GoFree GF 目标程序的自由运行 
GoProgramBreak* GPB 带暂停执行目标程序（指定地址） 
HardwareBreak（U/M/H） HB 指定硬件断点 
HardwareBreak（L） HB 指定硬件断点 
Help H 显示脚本命令的帮助 
Load L 目标程序的汇总下载 
LoadHex LH 下载机器语言信息（Intel HEX 格式文件） 
LoadMot* LM 下载机器语言信息（Motorola S 格式文件） 
LoadSymbol LS 下载源程序行/汇编程序符号信息 
Logoff - 关闭记录文件 
Logon - 打开记录文件 
Macro - 注册/参照自定义程序 
MacroPath MPATH 设定/参照自定义程序的路径 
Map - 参照/设定映像 
Module MOD 显示全部模块（目标名） 
Move - 以 1 字节单位传送存储器内容 
MoveWord* MOVEW 以 2 字节单位传送存储器内容 
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命令名 缩写名 内容 

MR* - 显示实时 OS 状态 
OverStep O 源级的跨步执行 
OverStepInstruaction OI 机器语言级的跨步执行 
Path - 指定源文件的路径 
Pause - 显示指定信息，等待按钮输入 
Print - 参照 C 语言变量表达式 
Protect（U/M/H） PT 指定存储器保护功能 
Quit - 结束调试程序 
Radix - 设定/参照常数的既定值 
Register R 参照指定寄存器的值 
Reload - 重新下载目标程序 
Reset - 目标程序的复位 
Return RET 源级的返回执行 
ReturnInstruction RETI 机器语言级的返回执行 
Scope - 显示当前作用域/更改作用域 
Script - 打开脚本文件 
Section SEC 显示段信息 
Set - 指定 C 语言变量表达式的数据 
SetMemoryByte MB 以 1 字节单位更改存储器内容 
SetMemoryDword* MD 以 4 字节单位更改存储器内容 
SetMemoryLword* ML 以 4 字节单位更改存储器内容 
SetMemoryWord* MW 以 2 字节单位更改存储器内容 
Sleep - 指定秒数的命令输入等待 
SoftwareBreak SB 显示/设定软件断点 
SoftwareBreakClear SBC 删除软件断点 
SoftwareBreakClearAll SBCA 删除全部软件断点 
SoftwareBreakDisable SBD 软件断点的无效 
SoftwareBreakDisableAll SBDA 全部软件断点的无效 
SoftwareBreakEnable SBE 软件断点的有效 
SoftwareBreakEnableAll SBEA 全部软件断点的有效 
Status - 显示目标程序的执行状态 
Step S 源级的逐步执行 
StepInstruction SI 机器语言级的逐步执行 
Stop - 目标程序的停止 
Symbol SYM 显示符号 
Time - 设定执行时间的显示 
TraceData（U/M/H） TD 实时跟踪结果的总线信号显示 
TraceList（U/M/H） TL 实时跟踪结果的反汇编显示 
TracePoint（U/M/H） TP 指定跟踪点 
UnAlias - 删除命令的別名定义 
UnAliasAll - 删除全部命令的別名定义 
Up* - 显示调用源函数 
UploadHex UH 将机器语言信息加载到 Intel HEX 格式文件 
UploadMot* UM 将机器语言信息加载到 Motorola S 格式文件 
Version VER 显示调试程序的版本 
Wait（U/M/H） - 等待命令输入 
Wait（L） - 等待命令输入 
Where* - 显示函数调用状况 
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第3章 错误信息一览表 

PD 的错误信息一览表如下所示： 
 

序号 错误信息 补充和对应 
0 内部错误：错误号没有被设定。 请与当地的瑞萨有关公司及经销商联系。 

 
序号 错误信息 补充和对应 
200 不能打开更多的 xxxxx Window。 打开的指定窗口数已为最大数。 
201 xxxxx Window 打开失败。  
202 PDxx 已被启动。 不能多次启动 PDxx。 
203 工程文件 xxxxx 已损坏。  
204 不能找到指定的文件 xxxxx。 请确认文件是否存在。 
205 不能找到指定的路径 path。 请确认指定的路径。 
206 由于存储器的容量不够，不能执行。 请结束其它应用程序或者增设存储器。 
207 不能执行。  
209 不能存取档案文件 xxxxx（CODE:n）。 文件（xxxxx）存取失败。请确认文件、目录的

存取属性以及其它应用程序是否使用此文件。 
210 不能存取文件 xxxxx（CODE:n）。  

 
序号 错误信息 补充和对应 
400 不能转换显示模式。 显示起始地址和源文件的起始行地址不一致，或

者不能找到相应的源文件。 
401 不能找到源文件（filename）。 不能找到指定的源文件。 请用 Path 命令或者

Customize 对话框（菜单[Environment]→
[Customize]）指定保存源文件的目录。 

402 不能找到检索字符串（string）。 从检索起始位置开始搜索到最后，没有找到指定

的字符串。 
403 源文件（filename）的行数已超过 xxx 行。 由于源文件的行数已超出能显示的行数，不能显

示源文件。将显示模式转换成反汇编显示模式。

 
序号 错误信息 补充和对应 
600 指定的地址超出了范围。 请指定范围内的地址。 
601 不能打开文件（string1）。  
602 不能找到源文件（string1）。  
603 由于编辑内容超过 xxx 行，不能保存。  
604 不能将编辑内容保存到文件（string1）。  

605 此文件（string1）正在被其它应用程序使用，

不能编辑。 
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序号 错误信息 补充和对应 
800 指定值超出了范围。 请指定范围内的值。 
801 不能找到寄存器信息文件。 重新安装 PDxx。 
802 寄存器信息文件的记述有错。 请与当地的瑞萨有关公司或者经销商联系。 
803 不能分配存储器。 存储器容量不够。请结束其它应用程序或者增设

存储器。 
804 表达式的记述有错。  

 
序号 错误信息 补充和对应 
1000 指定的地址超出了滚动范围。 请指定范围内的地址。 

 
序号 错误信息 补充和对应 
1200 指定的地址超出了滚动范围。 请指定范围内的地址。 
1201 发生了与显示数据长度不同的数据设定。  

 
序号 错误信息 补充和对应 
1400 采样周期的值超出了范围。 请指定范围内的值。 
1401 指定的地址超出了范围。 请指定范围内的值。 

 
序号 错误信息 补充和对应 
1600 由于监视点的点数超过了限制数（num），

不能追加。 
请确认监视点数。 

1601 指定的地址超出了范围。 请指定范围内的值。 
1602 指定的值超出了范围。 请指定范围内的值。 
1603 指定的位值超出了范围。 请指定范围内的值。 
1604 不能保存监视点。 请确认监视点的保存处是否为可写状态。监视点

的保存处能通过 Customize 对话框确认。 

 
序号 错误信息 补充和对应 
1800 符号信息没有被装入。 请装入符号文件。 
1801 字符串过长。  
1802 不能保存 C 监视点。 请确认监视点的保存处是否为可写状态。监视点

的保存处能通过 Customize 对话框确认。 

 
序号 错误信息 补充和对应 
2000 不能打开指定的脚本文件（filename）。 请确认脚本文件名。 
2001 没有打开脚本文件。 请打开脚本文件。 
2002 不能打开指定的记录文件（filename）。 请确认文件属性。 
2003 不能打开更多的记录文件。 请确认记录文件的嵌套数。 
2004 没有打开记录文件。 请打开记录文件。 
2005 指定的记录文件（filename）已被打开。  
2006 不能打开视图文件（filename）。  
2007 不能保存命令执行履历（xxxxx）。  
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序号 错误信息 补充和对应 
2200 指定的地址不正确。  
2201 指定的数据值超出范围。  
2202 起始地址大于结束地址的地址值。  
2203 指定的次数小于 1。  
2204 指定值超出范围。  
2205 没有设定数据。  

 
序号 错误信息 补充和对应 
2400 endi 过多（filename line）。 没有对应 endi 的 if。 
2401 endw 过多（filename line）。 没有对应 endw 的 while。 
2402 已读取脚本文件的最后行。  
2403 endi 不够（filename line）。 没有对应 if 的 endi。 
2404 行过长（filename line）。 超过了文字数的限制。 
2405 嵌套过深（filename line）。  
2406 不能找到脚本文件（filename）。  
2407 不能读脚本文件（filename）。  
2408 脚本文法错误（filename line）。  
2409 不能找到 endw（filename line）。 没有对应 while 的 endw。 
2410 脚本文件的嵌套超过了限制（num）。  
2411 内部错误：ER_BAT_NONE  请与当地的瑞萨有关公司或者经销商联系。 
2412 break 过多（filename line）。  

 
序号 错误信息 补充和对应 
2600 命令行的文法错误。  
2601 命令名有错誤。  
2602 过多注册了 alias。 请确认注册数。 
2603 对 alias 只能注册命令名。  
2604 因目标程序正在执行，不能使用指定的命令。  
2605 从此不能 up。  
2606 从此不能 down。  
2607 不能对子函数设定暂停。  
2608 起始地址大于结束地址的地址值。  
2609 对别名不能指定命令名和保留字。  
2610 现在不支持此命令。  
2611 不能找到文件（filename）。  
2612 指定的数据值超出范围。  

 
序号 错误信息 补充和对应 

6000 内部错误：ER_ENV_END  请与当地的瑞萨有关公司或者经销商联系。 

 
序号 错误信息 补充和对应 
6200 符号文件格式异常。 请重新建立文件。 
6201 停止符号文件的装入。  
6202 不能找到符号文件（filename）。 请确认文件名。 
6203 不能确保必要的存储器。 请结束其它应用程序或者增设存储器。 
6204 不能打开临时文件。 请确认驱动器的的剩余容量。 
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序号 错误信息 补充和对应 
6402 不能找到符号。  
6403 指定的表达式不能注册为监视点。  
6404 文法错误。  
6405 不能找到作用域。  
6406 不能找到符号。  
6407 不能找到函数。  
6408 表达式的右边不合适。  
6409 发生了不同型结构体（联合体）的复制。  
6410 不能代入。  
6411 不能找到型。  
6412 不支持浮点运算。  
6413 在指针型变量之间不能进行指定的运算。  
6414 不能对指针型进行指定的运算。  
6415 发生了由指针变量进行的减法运算。  
6416 被 0 除。  
6417 使用了不正确的运算符。  
6418 型信息已损坏。  
6419 左边值必须为指针变量。  
6420 左边值必须为结构体（联合体）型。  
6421 不能找到成员。  
6422 左边值必须为对结构体（联合体）型的参照。  
6423 左边值不适合。  
6424 操作数必须为数值。  
6425 指定的操作数不能符号反转。  
6426 不能计算地址值。  
6427 数组变量不适合。  
6428 数组的要素序号不适合。  
6429 操作数必须为地址。  
6430 不支持对寄存器变量的型转换运算。  
6431 型转换的型指定不适合。  
6432 不支持对指定型的型转换运算。  
6433 不能转换成地址的 C 表达式。  

 
序号 错误信息 补充和对应 
6601 指定的地址值超出范围。  
6602 已停止目标程序的执行。  
6603 断点的点数超过限制数（num）。  
6604 没有设定断点。  
6605 指定的数据值超出范围。  
6606 内部错误：发生了

ER_IN1_ILLEGAL_MODE（in string1） 
请与当地的瑞萨有关公司或者经销商联系。 

6607 由于在指定的区域中没有存储器，不能参照/

写。 
 

6608 指定的寄存器值超出范围。  
6609 因目标程序正在执行，不能使用指定的命令。  
6610 起始地址大于结束地址的地址值。  
6611 中止执行。  
6612 不能检索更多的堆栈。  
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序号 错误信息 补充和对应 
6613 指定的次数超过了 65535 次。  
6614 内部错误：在 Word 存取时，不能取得奇数

字节的存储器。 
请与当地的瑞萨有关公司或者经销商联系。 

6615 存储器校准错误。  
6616 指定的寄存器有错。  

 
序号 错误信息 补充和对应 
6800 中止处理。  
6801 由于在编辑中，不能执行此命令。 在存在编辑模式的窗口时，不能执行 Go 和 Step

等的命令。 

 
序号 错误信息 补充和对应 

10000 不能找到源文件（filename）。  
10001 源文件（filename）的行数超过 xxx 行。  
10002 指定的地址超出范围。  
10003 不能打开文件（filename）。  
10004 文件格式不正确。  
10005 不能读取由模拟调试程序保存的文件。  
10006 不能读取由仿真调试程序保存的文件。  
10007 由于存储器的容量不够，不能显示全部函数。  

 
序号 错误信息 补充和对应 

10200 不能找到操作码（code）。  
10201 不能打开文件（filename）。  
10202 给 xxxxx 设定了相同的事件。  
10203 文件（filename）格式有错。  

 
序号 错误信息 补充和对应 

10400 不能检索更多的 Come。  
10401 不能检索更多的 Step。  
10402 指定的周期值超出范围。  
10403 不能找到指定的地址值。  
10404 不能打开文件（filename）。  
10405 不能读取文件（filename）。  
10406 由于跟踪数据不够或者异常，不能更改成

BUS 模式以外的模式。 
 

 
序号 错误信息 补充和对应 

10600 不能打开按钮文件（filename）。  
10601 按钮文件格式异常。  

 
序号 错误信息 补充和对应 

10800 指定的文件格式不正确。  
10801 指定的地址不正确。  
10802 指定的数据值超出范围。  
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序号 错误信息 补充和对应 

11000 文件（flename）的内容有错。  
11001 不能找到文件（flename）。  
11002 不能打开文件（flename）。  
11003 不能存取文件（flename）。  
11004 不能存取档案文件（flename）。  
11005 指定值超出范围。  
11006 不能找到函数。  
11007 不能找到位符号。  
11008 在运行中不能设定跟踪点。  
11009 指定奇数地址时，只能指定字节存取。  

 
序号 错误信息 补充和对应 

11200 已设定硬件断点。  
11201 总线宽度和存取条件的组合不正确。  
11202 由于目标的类型不同，不能执行本命令。  
11203 起始周期大于结束周期的周期值。  
11204 在 H/W 断点设定窗口被打开的情况下，不能

使用 HardwareBreak 命令。 
 

11205 不能反汇编显示的跟踪数据。  
11206 在跟踪点设定窗口、区间时间测量窗口、MR

跟踪/解析窗口、Task 跟踪/解析窗口被打开

的情况下，不能使用 TracePoint 命令。 

 

11207 指定的周期值超出范围。  
 

序号 错误信息 补充和对应 
16000 内部错误：已经和目标处于连接状态。 请与当地的瑞萨有关公司或者经销商联系。 
16001 内部错误：发生 fork 错误。 请与当地的瑞萨有关公司或者经销商联系。 
16002 不能找到指定的主机名（host）。  
16003 内部错误：波特率的指定有错。 请与当地的瑞萨有关公司或者经销商联系。 
16004 没有和目标连接。 请确认连接。 
16005 不能连接到目标。 请确认连接。 
16006 内部错误：超时时间的设定超出范围。 请与当地的瑞萨有关公司或者经销商联系。 

 
序号 错误信息 补充和对应 

16007 发生超时错误。 请与当地的瑞萨有关公司或者经销商联系。 
16008 内部错误：目标的通信切断失败。  
16009 内部错误：不传送指定的数据容量。 请与当地的瑞萨有关公司或者经销商联系。 
16010 内部错误：参数的设定有错。 请与当地的瑞萨有关公司或者经销商联系。 
16011 主机名的指定有错。  
16012 发生了通信错误。切断和目标的连接。  
16013 发生了通信错误。不能给目标传送数据。  
16014 发生了通信错误。不能接收来自目标的数据。  
16015 目标已经被使用。  
16016 不能使用指定的通信 I/F。  
16017 在 Windows3.1 的环境下不能使用 LAN I/F。  
16018 在Windows NT的环境下不能使用并行通信 I/F。  
16019 通信 I/F 的设定内容不适合。 请确认设定内容。 
16020 在串行通信中发生了溢出错误。  
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序号 错误信息 补充和对应 

16200 指定的地址值超出范围。  
16201 现在不支持指定的波特率。  
16202 指定的位序号超出范围。  
16203 停止执行。  
16204 指定的数据值超出范围。  
16205 监控器文件（filename）已损坏。  
16206 不能找到文件（filename）。  
16207 没有正确构成目标系统。  
16208 内部错误：发生了

ER_IN2_ILLEGAL_MODE。（in string1）
请与当地的瑞萨有关公司或者经销商联系。 

16209 指定的屏蔽值超出范围。  
16210 时间测量计数器溢出。  
16211 PDxx 的版本和搭载于目标的固化软件的版

本不对应。 
 

16212 指定的通过次数值超出范围。  
16213 因目标程序在执行中，不能使用指定的命令。  
16214 现在目标 MCU 处于复位状态。请复位目标

系统。 
 

16215 现在目标 MCU 处于复位不可状态。请复位

目标系统。 
 

16216 现在目标 MCU 处于 HOLD 状态。  
16217 现在目标时钟处于停止状态。  
16218 现在目标 MCU 处于电源未供给状态。  
16219 内部错误：断点序号无效。 请与当地的瑞萨有关公司或者经销商联系。 
16220 请给目标下载固化软件。  
16221 固化软件下载失败。  
16222 不能找到能参照的跟踪数据。  
16223 指定的周期值超出范围。  
16224 目标 MCU 已失控。请复位目标系统。  
16225 第 1 比较数据大于第 2 比较数据的值。  
16226 第 1 比较地址大于第 2 比较地址的值。  
16227 在状态转移的路径上没有设定事件。  
16228 指定的超时值超出范围。  
16229 指定的进程 ID 超出范围。  
16230 通信协议错误（参数错误）。 请与当地的瑞萨有关公司或者经销商联系。 
16231 从仿真器发送了未定义的状态。  
16232 发生接收数据的校验和错误。  
16233 不存在指定的数据。  
16234 目标程序在执行中。  
16235 目标程序在停止中。  
16236 已处于测量停止状态。  
16237 已处于测量执行状态。  
16238 测量没有结束。  
16239 不存在指定周期的跟踪数据。  
16240 没有跟踪数据。  
16241 时间测量计数器溢出。  
16242 通过強制复位解除 POF 状态。  
16243 点的设定点数超出范围。  
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序号 错误信息 补充和对应 

16244 没有设定程序暂定。  
16245 没有装入源程序行信息。  
16246 触发模式不为软件输出。  
16247 在逐步执行中检测到异常处理。  
16248 函数范围超出设定范围。  
16249 发生了对 EEPROM 的写错误。  
16252 指定了不能执行的命令码。  
16253 处理器模式和目标系统不一致。使用 xxxxx

模式调试。 
 

16254 没有将指定的存储体定义成扩展存储器。  
16255 设定的存储体被重复。  
16256 指定的区域包含调试监控程序存储区。  
16257 指定的区域包含调试监控程序工作区。  
16258 发生了闪存擦除错误。  
16259 发生了闪存验证错误。  
16260 指定的区域包含内部（闪存）ROM 区。  
16261 在对大小指定 Word 时，不能指定奇数地址。  
16262 指定了超过仿真存储器范围的区域。  
16263 将指定的区域定义成外部区域。  
16264 指定值中有此处理器模式不能使用的值。  
16265 MCU 的 RDY*管脚为 Low 电平。  
16266 MCU 的 HOLD*管脚为 Low 电平。  
16267 解除指定的区域中设定的程序暂定。  
16268 请指定仿真存储区内的地址。  
16269 仿真存储区的设定有错。  
16270 已由调试监控程序存储体地址使用。  
16271 不能注册更多的仿真存储区。  
16272 不能指定存储体 0～3。  
16273 调试监控程序存储体地址的指定有错。  
16274 调试监控程序工作地址有错。  
16275 不能跨越指定 2 个以上的存储体。  
16276 请指定仿真存储区内的地址。  
16277 不能注册更多的 ROM 区。  
16278 起始地址大于结束地址的地址值。  
16279 不能注册更多的 DMA 区。  
16281 DMA 区的设定有错。  
16282 在给大小指定 Word 时，不能指定奇数地址。  
16283 不能注册更多的存储器映像。  
16284 存储器映像的设定有错。  
16285 请指定仿真存储区内的地址。  
16286 仿真存储区的设定有错。  
16287 已由调试监控程序存储体地址使用。  
16288 不能注册更多的仿真存储区。  
16289 不能指定存储体 0～3。  
16290 调试监控程序存储体地址的指定有错。  
16291 调试监控程序工作地址有错。  
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序号 错误信息 补充和对应 

16292 不能跨越指定 2 个以上的存储体。  
16293 请指定仿真存储区内的地址。  
16294 不能注册更多的 ROM 区。  
16295 起始地址大于结束地址的地址值。  
16296 不能注册更多的 DMA 区。  
16298 DMA 区的设定有错。  
16299 不能注册更多的 8 位总线模式区。  
16300 8 位总线模式区的设定有错。  
16301 在给大小指定 Word 时，不能指定奇数地址。  
16302 不能给 SFR区、内部 RAM区设定 S/W 断点。  
16303 不能给闪存区设定 S/W 断点。  
16304 不能设定 S/W 断点。  
16305 不能给 SFR区、内部 RAM区设定 H/W 断点。  
16306 不能给闪存区设定 H/W 断点。  
16307 不能设定 H/W 断点。  
16308 不能注册更多的存储器映像。  
16309 存储器映像的设定有错。  
16310 目标 MCU 为睡眠模式。  
16311 目标 MCU 为待机/停止模式。  
16312 目标 MCU 为非刷新待机模式。  
16313 MCU 为 HOLD 状态。  
16314 工作区的地址值超出范围。  
16315 接收数据异常。接收数据必须为“x”，但是

接收到“y”。 
 

16316 接收 INIT 代码。  

 
序号 错误信息 补充和对应 

20000 不能找到指定任务序号的任务。  
20001 不能找到指定任务序号的上下文。  
20002 MR 的数据已损坏。  
20003 不能确保必要的存储器。  

 
序号 错误信息 补充和对应 

20200 不能找到符合检索条件的系统调用发行履历

信息。 
 

 
序号 错误信息 补充和对应 

20400 现在的目标程序不能使用任务暂停功能。  
20401 任务暂停处理（xxxxx）失败。  

 
序号 错误信息 补充和对应 

20600 由于没有设定必要的信息，本窗口不作用。  
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序号 错误信息 补充和对应 

20800 保存文件名（filename）不正确。  
20801 不能找到 MR 的符号信息（xxx）。  
20802 没有执行 MR 的初始化程序。  
20803 不能找到指定任务序号的任务。  
20804 优先级超出范围。  
20805 任务 ID 超出范围。  
20806 标志 ID 超出范围。  
20807 信标标志 ID 超出范围。  
20808 邮箱 ID 超出范围。  
20809 存储库 ID 超出范围。  
20810 周期启动处理程序 ID 超出范围。  
20811 地址超出范围。  
20812 不能发行系统调用。  
20813 没有发行系统调用。  
20814 没有结束系统调用的发行。  
20815 指定的地址值超出范围。  
20816 文件名不合适。  
20817 MR 的数据已损坏。  
20818 不能确保必要的存储器。  

 
序号 错误信息 补充和对应 
26000 指定的地址值超出范围。  
26001 汇编语言的记述有错。  
26002 转移目标地址超出范围。  
26003 指定操作数的值超出范围。  
26004 表达式的记述有错。  
26005 寻址模式说明符的记述有错。  
26006 内部错误：'ALIGN' is multiple specified in 

'.SECTION'. 
请与当地的瑞萨有关公司或者经销商联系。 

26007 没有定义操作数的值。  
26008 表达式中有位符号。  
26009 有无效的位符号。  
26010 值不为汇编时的确定值。  
26011 重复指定操作数的同一项目。  
26012 重复指定操作数的同种类项目。  
26013 在指令或者表达式中有多余的字符。  
26014 格式说明符的记述有错。  
26015 符号的定义有错。  
26016 在操作数中记述了保留字。  
26017 内部错误：'JMP.S' operand label is not in 

the same section. 
请与当地的瑞萨有关公司或者经销商联系。 

26018 没有保留字的记述。  
26019 在助记符、汇编指示指令的后面有空白字符。  
26020 内部错误：No '.FB' statement. 请与当地的瑞萨有关公司或者经销商联系。 
26021 内部错误：No '.SB' statement. 请与当地的瑞萨有关公司或者经销商联系。 
26022 内部错误：No '.SECTION' statement. 请与当地的瑞萨有关公司或者经销商联系。 
26023 没有定义操作数的值。  
26024 操作数的大小错误。  
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序号 错误信息 补充和对应 
26025 操作数的种类错误。  
26026 内部错误：Section attribute is not defined. 请与当地的瑞萨有关公司或者经销商联系。 
26027 内部错误：Section has already determined 

as attribute. 
请与当地的瑞萨有关公司或者经销商联系。 

26028 内部错误：Section name is missing. 请与当地的瑞萨有关公司或者经销商联系。 
26029 内部错误：Section type is not appropriate. 请与当地的瑞萨有关公司或者经销商联系。 
26030 内部错误：Section type is multiple 

specified. 
请与当地的瑞萨有关公司或者经销商联系。 

26031 大小说明符或者格式说明符的记述有错。  
26032 没有大小指定符。  
26033 表达式中记述了字符串表达式。  
26034 没有符号的记述。  
26035 符号已被定义。  
26036 没有用“.EQU”、“.BTEQU”定义的符号

名的记述。 
 

26037 符号已被定义。  
26038 在指令中有无效的操作数。  
26039 表达式的记述有错。  
26040 在指令中有无效的操作数。  
26041 操作数记述不够。  
26042 有多余的操作数。  
26043 操作数的数据过多。  
26044 有未定义的符号。  
26045 值超出范围。  
26046 被 0 除。  
26047 内部错误：'.VER' is duplicated. 请与当地的瑞萨有关公司或者经销商联系。 
26048 没有“#”的记述。  
26049 没有“,”的记述。  
26050 没有“]”的记述。  
26051 没有“）”的记述。  
26052 内部错误：Symbol defined by external 

reference data is defined as global symbol.
请与当地的瑞萨有关公司或者经销商联系。 

26053 在指令中有无效的操作数。  
26054 没有对字符串的引号记述。  
26055 没有右侧的引号。  
26056 不能获得存储器。  
26057 直接寻址选择模式和记述模式不一致。  
26058 没有“:”的记述。  
26059 不能为绝对寻址。  
26060 不能为直接寻址。  
26061 表达式中有不适合的寻址模式声明的符号。  
26062 间接寻址模式的记述有错。  
26063 没有“（”的记述。  
26064 内部错误：Internal error.  
26065 指定的操作数超出直接寻址范围。  
26066 指定的操作数超出绝对寻址范围。  
26067 指定的操作数超出绝对长字寻址范围。  
26068 指定的操作数超出堆栈相对寻址范围。  
26069 指定的操作数不正确。  
26071 不能指定奇数地址。  
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序号 错误信息 补充和对应 

26200 行号的指定有错。  
26201 不能找到右括弧“）”。  
26202 宏常数的个数超过限制数（num）。  
26203 指定的常数值超出范围。  
26204 表示常数基数的前缀记述有错。  
26205 间接参照的记述有错。  
26206 不能找到表示字符串的结尾（xxx）。  
26207 表达式的记述有错。  
26208 没有定义宏常数（macro）。  
26209 没有定义符号（symbol）。  
26210 常数值的记述有错。  
26211 被 0 除。  
26212 解析结果超过了 MCU 的处理最大值。  
26213 宏变量名使用了寄存器名。  

 
序号 错误信息 补充和对应 

26400 指定的地址值超出范围。  
26401 指定的位序号超出范围。  
26402 文件（filename）已损坏。  
26403 不能找到文件（filename）。  
26404 不能找到函数/子程序信息。  
26405 在字符串中有作为符号/标号不能记述的字符。  
26406 内部错误：发生了

ER_LOAD_ILLEGAL_MODE。（in string1）
请与当地的瑞萨有关公司或者经销商联系。 

26407 不能找到指定的行号。  
26408 同名的符号/标号已被注册。  
26409 指定的行号不能生成机器语言。  
26410 不能确保必要的存储器。  
26411 不能找到作用域。  
26412 不能找到段信息。  
26413 不能找到符合指定地址的源程序行。  
26414 不能找到符号（symbol）。  
26415 不能找到包含指定地址的作用域。  
26416 中止装入。  
26417 内部错误：函数外。 请与当地的瑞萨有关公司或者经销商联系。 
26418 内部错误：段信息的结尾。 请与当地的瑞萨有关公司或者经销商联系。 
26419 寄存器名有错。  
26420 不能找到源文件（filename）。  
26421 不能读取装入模块文件（filename）。  
26422 路径不正确。  
26423 不能打开保存文件（filename）。  
26424 不能打开 SYSROF 文件。  
26425 不能读取 SYSROF 文件。  
26426 不是绝对地址形式的格式。  
26427 文件的内容有错。  
26428 存储器容量不够。  
26429 没有指定的文件。  
26430 在指定的行中没有地址。  
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序号 错误信息 补充和对应 

26431 没有相应的函数。  
26432 没有相应的作用域地址。  
26433 没有相应的符号。  
26434 没有相应的函数。  
26435 中止装入。  
26436 内部错误：发生了 ER_LOAD_SYMSCOPE。  
26437 文件名有错。  
26438 没有显示源文件。  
26439 指定路径的路径名过长。  

 
序号 错误信息 补充和对应 

26600 不存在输入的文件（filename）。  
26601 不能建立文件（filename）。  
26602 不能关闭文件（filename）。  
26603 发生了查找错误。（in string1）  
26604 磁盘容量不够。  
26605 在文件（filename）中存在没有被规定的数据

（string2）。（string3） 
 

26606 用于运行的存储器不够。  
26607 不支持此数据（data）。  

 
序号 错误信息 补充和对应 

30200 请再次确认处理器模式的指定和各管脚电平

是否正确。 
 

30201 请再次确认存储体的指定是否正确。  

 
序号 错误信息 补充和对应 

30400 指定的 MCU 文件为旧格式。  
30401 MCU 文件的记述有错。  

 
序号 错误信息 补充和对应 

30600 在连接仿真 POD 时，目标时钟必须固定为

外部时钟。 
不能更改为内部时钟。 

 
序号 错误信息 补充和对应 

38000 存储体值不正确。  
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